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1. INTRODUCTION

OpenOffice.org (appelé aussi OOo) est une suite bureautique libre régie par la licence LGPL (GNU 

Lesser General Public License) qui permet à n'importe quelle personne de l'utiliser et de la distribuer 

gratuitement.

Elle comprend :
1. un traitement de texte (analogue à Word®)
2. un tableur (similaire à Excel®)
3. un logiciel de présentation (Powerpoint®) 
4. un gestionnaire de base de données (Access®) 
5. un logiciel de dessin 
6. un éditeur d'équations mathématiques
Cette dernière fonctionne sous de très nombreux systèmes d'exploitation comme :
1. Windows 
2. GNU/Linux 
3. Macintosh
4. Solaris 
5. FreeBSD

Elle est proposée en plus de 44 langues différentes, dont le français bien entendu. Ces dernières années, 
OOo s'est imposée comme la seule concurrente sérieuse à Microsoft Office®. Cette suite a d'ailleurs 
été adoptée par un grand nombre d'entreprises et d'administrations, y compris en France au sein de la 
Gendarmerie Nationale par exemple, soucieuses de s'affranchir de la dépendance de fait établie vis-à-
vis de l'éditeur américain Microsoft. En 2007, il y a eu lieu la plus grande migration OpenOffice.Org 
dans le monde : 400.000 postes de l'administration centrale française. 

1.1 Rappel historique

A l'origine, cette suite bureautique est issue d'un produit commercial, vendu par la société StarDivision 

qui a ensuite été rachetée par Sun, sous la dénomination de StarOffice.

Ce n'est qu'en octobre 2000 que Sun a décidé d'offrir le code source de StarOffice à la communauté. 

Maintenant sous licence libre, cette suite bureautique changea de nom en OpenOffice.org.

Anecdote : la dénomination exacte est en effet OpenOffice.org et non pas OpenOffice, car ce nom était 

déjà déposé à l'époque.
Parallèlement au développement d'OpenOffice.org, Sun a continué à développer la suite bureautique 
StarOffice, actuellement disponible en version 8.0, mais toujours sous la forme d'un produit 
commercial donc payant, contrairement à OpenOffice.org qui est gratuit.
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Remarque : bien que gratuite, la dernière version 2.3 d' OOo, que nous allons vous présenter en détail 
dans ce dossier, constitue une véritable suite bureautique, qui rivalise maintenant sans difficulté avec 
ses concurrentes commerciales comme Microsoft Office®. Que vous soyez un particulier ou une 
entreprise, cette suite pourra sans aucun doute vous satisfaire.

Evidemment, tout n'est jamais rose dans ce monde, et certains problèmes peuvent apparaître, 
notamment la compatibilité avec les fichiers de la suite de Microsoft®, leader du marché. Mais nous 
vous montrerons que ces problèmes ne constituent plus aujourd'hui, à mon sens, un frein au 
développement d'OOo, bien au contraire puisque cette dernière se paye même le luxe de proposer des 
fonctionnalités inédites que Microsoft Office® ne possède pas (encore) comme par exemple la création 
native de fichiers au format PDF, ou le support du format Open Document (un analogue au format 
XML) qui s'annonce comme véritablement révolutionnaire.

Si vous avez besoin d'une suite bureautique complète, fonctionnelle, et puissante, le choix 
d'OpenOffice.org devrait s'imposer, d'autant plus que cette dernière est proposée gratuitement, ce qui 
vous permettra pour certains d'effectuer des économies, et pour d'autres de revenir dans la légalité !

OpenOffice.org est une suite bureautique qui comprend de nombreux logiciels en son sein, chacun 

dédié à une fonction spécifique.
On y retrouve en fait 6 applications :

1. Writer : un traitement de texte, similaire à Word®, qui permet de réaliser n'importe quel document 

de type bureautique.

2. Calc : un tableur (similaire à Excel®) qui permet de calculer, analyser et de communiquer 

visuellement vos données. il dispose d'outils permettant de générer des diagrammes en 2D ou 3D.

3. Impress : un logiciel de présentation multimédia (Powerpoint®) qui permet de créer des effets, et 

animations afin de rendre ces dernières plus vivantes.

4. Draw : un logiciel de dessin vectoriel et de PAO qui permet de créer de simples diagrammes à des 

illustrations dynamiques en 3D avec des effets spéciaux.

5. Base : un gestionnaire de base de données (Access®) qui permet de manipuler des données de base 

de données. Vous pourrez créer et modifier des tables, des formulaires, des rapports,... en utilisant 
votre propre base de données ou le moteur de base de données HSQL incorporé.

6. Math : qui permet de créer des équations et autres formules mathématiques, analogue à l'éditeur 

d'équation contenu dans Word®.
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Bien entendu, ces logiciels sont les équivalents de ceux proposés par Microsoft® au sein de sa suite 
bureautique commerciale Microsoft Office®.

Notons toutefois que OpenOffice.org 2.3 ne dispose pas d� un client de messagerie, à l� image 

d�Outlook® chez Microsoft®. Il faudra donc utiliser un logiciel comme Thunderbird par exemple qui 

est utilisable gratuitement.

De même, OOo ne dispose pas d'un véritable équivalent au logiciel Front Page® (éditeur HTML), ni à 

Publisher® (qui permet la conception et la composition de supports de communication et de 

documents commerciaux). On peut cependant trouver des programmes libres proposant des 

fonctionnalités similaires comme respectivement NVU et Scribs.

Comme vous pouvez le constater, OpenOffice.org 2.3 est une suite bureautique complète, qui devrait 
apporter satisfaction au plus grand nombre.

1.2 OpenOffice.org, logiciel libre

En effet, une des particularités de la suite bureautique OpenOffice.org est qu'elle est libre.

Pour beaucoup, ce concept ne signifie malheureusement pas grand chose, alors qu'il s'agit d'une 

véritable philosophie, il est donc important que vous sachiez bien l'appréhender.

Qu'est-ce-qu'un logiciel libre ?

En résumé, un logiciel libre est un logiciel dont le code source est disponible et surtout modifiable à 
volonté.

A l'opposé des logiciels libres, on retrouve ainsi les logiciels propriétaires, qui eux gardent jalousement 
secret leur code source et empêchent toute modification de ce dernier.

Les logiciel libres sont protégés par une licence spécifique extrêmement précise qui autorise 
notamment :
1. tout utilisateur à recopier le programme à volonté, et ceci quel qu'en soit l'usage (personnel ou 

professionnel)
2. à redistribuer le programme sans avoir de compte à rendre au créateur du programme ou à une 
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société
3. tout utilisateur à pouvoir lire, modifier et redistribuer le code source du programme 

Bref, vous avez le droit d'utiliser un logiciel, de le copier, de le modifier et de le redistribuer, tout ceci le 
plus légalement du monde.

Pour information, la plus célèbre licence de ce type est la GPL pour G.N.U. General Public Licence.

(GNU Lesser General Public License) qui ne diffère de la GPL que par des contraintes vis-à-vis des 
développeurs, elle permet donc également à n'importe quel utilisateur de l'utiliser et de la distribuer 

gratuitement.

Comme vous pouvez le constater, le monde du logiciel libre se traduit par un esprit de partage du 
savoir, ce qui est à saluer de nos jours !
Pour les utilisateurs que nous sommes, utiliser des logiciels libres présente de nombreux avantages.
L'utilisation de logiciels libres permet ainsi :

• de rester dans la légalité, réduisant ainsi à néant le problème du piratage.
• de réaliser des économies, les logiciels étant gratuits ( idem en entreprise ou le problème des 

licences disparaît )
• de gérer de manière plus souple l'installation des programmes ( pas de processus d'activation ou 

de numéro de série à indiquer à la Microsoft )
• de disposer d'un code source ouvert, qui peut être amélioré par vous même ou d'autres, afin de 

mieux vous correspondre
• à long terme, de garantir la pérennité de vos données. En effet, si vos données sont enregistrées 

via un format propriétaire et que cette société disparaisse ou ne souhaite pas que ses concurrents 
puissent utiliser son format, vous êtes condamné à la perte de vos données. 

1.3 XML, un grand avantage

Un des grands avantages, mais souvent très mal connu, de la suite bureautique OpenOffice.org 

2.3 est son support natif du XML.

Une des grande batailles engagée entre Microsoft Office® et OpenOffice.org repose en effet sur la 
maîtrise des formats de fichiers, pour l'un propriétaire et fermé, pour l'autre libre et ouvert.
Le choix du format libre XML par OOo (plus exactement du format Open Document) va avoir de 
nombreuses conséquences sur la façon de travailler les documents. Ainsi, par exemple, les contenus et 
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styles sont stockés séparément. De même tous les enrichissements que vous effectuerez sur votre texte 
seront appliqués par l'intermédiaire de feuilles de style et non pas directement sur les éléments du 
document. Pas d'inquiétude, pour les utilisateurs que nous sommes, tout ceci est transparent !

Quelle utilisation pour le XML ?

L'autre grande bataille est la lutte pour l'échange et la pérennité des données.
La bataille de l'information règne aujourd'hui, et il apparaît en effet de plus en plus important, 
notamment pour les entreprises, mais également pour les particuliers, de pouvoir s'échanger des 
données entre des plate-formes hétérogènes. 

En effet, stocker et gérer des données hétérogènes et peu structurées, comme le sont les données 
bureautiques (documentation technique, rapport, projets, etc.) devient de plus en plus complexe.

Il devient donc de plus en plus critique de pouvoir gérer, partager et valoriser ces flux d'informations, et 
c'est précisément la que le format ouvert XML intervient.

Définition : le XML est un un méta-format de données qui sert à définir des formats de données. Il 
fournit des outils pour formaliser cette définition (DTD, XML Schemas, Relax NG,..), par exemple 
pour effectuer des recherches dans un document

Il apparaît donc plus facile de créer des formats de données adaptés. Ainsi même si les formats 
diffèrent, les outils de manipulation restent eux communs, ce qui permet de rendre les formats 

facilement interopérables.

OpenOffice.org possède ainsi la particularité de produire nativement du XML, d'ailleurs sans que 
l'utilisateur ne s'en aperçoive !

Plus concrètement, le format de stockage d'OpenOffice.org est un format XML, qui a d'ailleurs servit 

de base de travail par l'OASIS pour créer le standard OpenDocument, adopté en mai 2005.

Pour les spécialistes, sachez que OpenDocument est très semblable au format XML, mais comporte 
quelques améliorations, comme la gestion d'OLE ou de SVG.

OpenOffice.org 2.3 supporte bien entendu le format OpenDocument de façon native, et est ainsi 
capable d'éditer tout type de format XML, comme le XHTML ou encore les fichiers Word® 2003 
XML.
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Plus concrètement, pour nous autres utilisateurs, l'utilisation d'un format reconnu, standardisé, et 
intéropérable constitue un gage de pérennité pour nos données, avec l'assurance de pouvoir y accéder 
même dans des années, ce qui n'est pas forcément le cas avec des formats propriétaires, en cas par 
exemple de disparition de la société ou des applications compatibles.

Remarque 1 : tous les fichiers enregistrés au format XLM par OOo 2.3 sont en même temps 

compressés en utilisant la compression de type ZIP. Ceci permet ainsi de générer un gain de place 

très important dans la taille des fichiers (ce qui n'existe pas chez Microsoft Office®), avec comme 
autres conséquences une réduction des  temps de sauvegardes ou de transferts des données.

Remarque 2: outre le XML, OOo gère également en natif le format PDF d'Adobe, universellement 

employé pour l'échange de documents (ce que ne propose pas Microsoft Office®, du moins pas avant la 
future Office 12 disponible pas avant l'automne 2006).

De même il utilise Xforms, le standard de formulaires pour la manipulation et l'échange des données 

structurées en XML, qui est analogue à son concurrent Microsftien InfoPath.

 - Le cas Microsoft Office® 2003 XML

Nous avons vu qu'OpenOffice.org utilise un standard nommé OpenDocument, basé sur de l' XML, 

gage d'une meilleure intéropérabilité des système.

Cependant, du côté de Microsoft aussi, avec Office 2003 en particulier, on parle de plus en plus 

d'intéropérabilité avec l'intégration du XML dans les logiciels Word®, Excel®, Frontpage  et Visio® 

(mais pas dans Powerpoint® ni Access).

Le premier problème avec ces produits est que Microsoft continue, par défaut, de proposer aux 
utilisateurs de sauvegarder leurs documents dans le format binaire, propriétaire, et non complètement 
documenté de la suite Office 97/2000/XP (les fameux .doc de Word® par exemple).

A priori, on pourait penser que Microsoft va dans le bon sens en proposant un support, même partiel, 
du XML, mais une analyse plus poussée nous montre le contraire.

En effet, très récemment, Microsoft a obtenu un brevet sur "l'utilisation d'un schéma XML pour valider  

le document XML de sortie d'un traitement de texte", ce qui signifie que si on applique ce brevet à la 
lettre, n'importe quel logiciel de traitement de texte utilisant le XML pour lire ou écrire un document 

Formation OpenOffice.org -- Moving Art Studio a.s.b.l.-- page 8



XML, excepté via  le format WordML® de Microsoft®, est considéré comme hors-la-loi !

Et c'est là que réside l'astuce. En effet, Microsoft® met à disposition ses formats WordML® et 

ExcelML®, et autorise leur utilisation gratuitement au sein de n'importe quel logiciel. Bref, il fournit 

gratuitement un format dit libre mais personne n'a le droit d'utiliser autre chose que ce même format 
sans tomber sous le coup de son brevet...on appréciera la technique de standardisation forcée ;)

Heureusement, cette situation ne concerne que les USA, ce brevet n'étant pas applicable en Europe.
De plus, la Commission Européenne a mis en concurrence les formats XML de Microsoft® et ceux d' 
OpenOffice.org, et a finalement décidé de choisir le format OpenDocument !
Bref, le format utilisé par OpenOffice.org est un format d'avenir, ouvert et qui apporte toutes les 
garanties possibles.

Avant de vous présenter dans le détail la suite bureautique OpenOffice.org 2.3, voyons tout d'abord son 
installation, présentée ici sous Windows sous la forme d'un tutorial.
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2. INSTALLATION D'OPENOFFICE.ORG SOUS WINDOWS

Télécharger OpenOffice.org 2.3  depuis le site http://download.openoffice.org/other.html

(choix de la langue et du système d'exploitation)
Remarque : pour disposer de toutes les fonctionnalités d'OpenOffice.org 2.3, il vous faudra également 
installer l'environnement d'exécution Java JRE.
Une fois le fichier de près de 76 Mo téléchargé, exécutez le.

Cliquer sur "Suivant" pour continuer.
A ce niveau, il faut indiquer un répertoire dans lequel l'exécutable va être décompressé. Attention, il ne 
s'agit pas ici du répertoire dans lequel sera installé définitivement la suite bureautique, mais juste d'un 
répertoire temporaire servant à la décompression des fichiers.
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La décompression des fichiers commence.
L'installation peut maintenant démarrer. Cliquer sur "Suivant".

Il faut accepter la licence avant de pouvoir cliquer sur "Suivant".

Indiquez votre nom d'utilisateur et, si nécessaire, le nom de votre organisation (facultatif).
Le programme vous propose ici deux choix, à savoir installer le programme pour tous les utilisateurs de 
votre PC, ou uniquement pour votre session.
Remarque :  si vous choisissez une configuration multiutilisateurs, vous devez être logué sur une 
session administrateur.
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Vous avez le choix entre une installation automatique, qui installe la suite complète, ou une 

installation personnalisée, si par exemple vous ne souhaitez pas installer un ou plusieurs composants 

de la suite, comme Base par exemple.

Le programme d'installation vous demande si vous souhaitez associer les fichiers de type Word®, 
Excel® ou Powerpoint® à OpenOffice.org. Si vous cochez ces cases, lorsque vous ouvrirez un 
fichier .doc par exemple, ce dernier s'ouvrira directement dans OOo même si vous avez Word® installé 
sur votre ordinateur.
Cliquer sur "Suivant" puis sur "Installer".

Voila, l'installation d'OpenOffice.org 2.3 est terminée.
Après l'installation, la première fois que vous lancerez n'importe quel logiciel d' OpenOffice.org, il vous 
sera demandé d'accepter la licence du produit, d'entrer votre nom et de vous enregistrer.
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Cliquez sur "Suivant", et faîtes défiler la licence pour pouvoir cliquer sur "Accepter". Indiquez ensuite 
vos prénom, nom et initiales.
Il vous reste alors finalement à accepter ou non de vous enregistrer, en sachant qu'il s'agit d'une étape 
facultative. Cliquer ensuite sur "Terminer".

Le logiciel se lance alors, et vous n'aurez plus jamais à recommencer cette étape de configuration, 
même pour les 5 autres logiciels de la suite.

Remarque : à cette étape, si vous disposez d'un outil comme Microsoft AntiSpyware®, une demande 
d'autorisation vous sera faîte. Il s'agit juste d'autoriser, ou non, un programme nommé "quickstart.exe" à 
se lancer au démarrage de votre session Windows®. Si vous acceptez, une icône apparaîtra près de 

l'horloge (au niveau du systray) nommée "Démarrage rapide de OpenOffice.org 2.3".
Son rôle est de proposer un accès rapide à l'ensemble des logiciels de la suite, et également d'accélérer 
le chargement des logiciels ( analogue à ce que propose Microsoft Office® ). Vous pouvez donc le 
désactiver si vous le souhaitez afin, par exemple, d'économiser de la mémoire sur les petites 
configurations.
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3. PRÉSENTATION D'OPENOFFICE.ORG

3.1 OOo, une suite intégrée

La principale caractéristique de la suite OpenOffice.org est d'être une suite intégrée. Cela veut dire 
qu'au contraire de la suite Microsoft dans laquelle les outils (traitement de texte, tableur, présentation) 
sont des logiciels distincts que l'on peut démarrer séparément, le lancement de OpenOffice.org met à 
disposition tous les outils ensemble.

Il suffit d'activer la commande Fichier>Nouveau pour constater que dans chaque composant de la suite, 
il est possible d'accéder aux autres outils. Ainsi, une feuille de calcul peut être ouverte alors que l'on 
utilise le traitement de texte.

L'avantage d'une suite intégrée réside justement dans cette intégration poussée des composants et dans 
les facilités d'utilisation que cela procure.

En revanche, il est évident que le logiciel est plus complexe et volumineux et que son temps de 
démarrage est plus long qu'avec des outils séparés.

Word® 2003 Writer ( OOo 2.3 )

Writer est un traitement de texte, similaire à Word®, qui permet de réaliser n'importe quel 

document de type bureautique.

Pour ceux qui ne connaissent pas ce logiciel, pas d'inquiétude inutile, si vous maîtrisez Word®, vous 

maîtriserez immédiatement Writer tant l'interface graphique et les fonctions ont été calquées sur son 

homologue Microsoftien, comme indiqué sur les deux captures cidessous.
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Comme vous pouvez le constater, l'interface graphique et les options sont quasi strictement les mêmes 
lorsque vous créez un document vierge.

Dans ce dossier, je ne présenterai pas toutes les potentialités de Writer, tant elles sont similaires à celles 
de Word®, et pourraient constituer à elles seules un dossier !

Nous essaierons de présenter les avantages et inconvénients de Writer par rapport à son concurrent 
direct Mi  crosoft Word®  , histoire de vous montrer, ou non, si une migration est envisageable.

Temps de chargement : une des grandes critiques des utilisateurs d' OOo concernait le temps de 

chargement de Writer, jugé beaucoup plus élevé que celui de Word®. J'ai donc effectué quelques tests 
afin de vous convaincre...du contraire ;)

Nous avons ici analysé les temps de chargement de Writer et de Word®, après avoir effectué une 
défragmentation du disque dur.

• Word® 2003 : la première fois que vous lancez Word®, le chargement est très rapide, estimé à 

environ 2 secondes. Pour les re-démarrages ultérieurs, ce temps passe à environ 1 seconde, 

autant dire quasi instantané.

• Writer : la première fois que vous lancez Writer, juste après le démarrage de votre session 

Windows, vous voyiez apparaître le logo d'OpenOffice.org et devrez attendre environ 6 à 7 

secondes avant de pouvoir commencer à rédiger un texte. Ensuite, si vous fermez Writer, et que 

vous le relancez ultérieurement le programme, ce temps de démarrage passe à environ 2 

secondes.

Bref, comme vous pouvez le constater, sans contestation possible, Word® démarre toujours plus 
rapidement que Writer, mais la différence ne joue que sur maximum 5-6 secondes, ce qui ne devrait pas 
poser de problèmes "insurmontables" à la plupart d'entre vous !

Consommation mémoire : comparons maintenant la consommation en mémoire, qui peut-être un 

point critique pour les petites configurations équipées, par exemple,  de moins de 128 Mo de RAM.

Writer occupe environ 37 Mo en mémoire lors de son lancement, sous la forme de deux processus 

Windows ( soffice.exe et soofice.bin  ).

Par comparaison, Word® occupe, lors de son démarrage, environ 11 Mo en mémoire ( processus 

winWord®.exe ), mais monte très vite à 28 Mo dès lors que vous tapez seulement quelques 

phrases de texte.
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Si on insère maintenant des images dans notre document, l'écart entre Writer et Word® est nul, avec 

environ 47 Mo pour Writer contre 48 Mo pour Word®.

Bref, en utilisation normale, la consommation mémoire semble équivalente entre les deux 

traitements de texte et ne peut constituer un critère de choix.

3.2 Le bureau OpenOffice.Org 2.3

3.2.1 L'interface

L'interface du bureau de OpenOffice.org comporte 5 barres d'outils visibles :

• La barre de menu qui liste les commandes selon une présentation par menu

• La barre de outils qui comporte les icônes d'exécution des actions les plus communes (ouvrir, 

fermer, enregistrer, couper, copier, coller, imprimer,) ;

• La barre d'objets avec les icônes de formatage (caractères, alignement, couleurs, ...) propres 

au module utilisé ;

• La barre d'instruments avec les outils spécifiques du module affiché pour insérer des 

champs, des données, des formes, des images et tout type d'objets ;

• La barre d'état des documents qui affiche les informations sur la page courante : modèle 

courant, % de zoom, mode insert ou refrappe, mode de sélection, mode hyperlien.
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3.2.2 Les options 

Dans le menu Outils > Options, on peut trouver des options de configuration tels quels p.ex. :

• Activer les infobulles, les infoballons et l�assistant d�aide (dans Général)

• Changer le chemin des emplacements par défaut p.ex. Mes Documents, Mes modèles (dans OpenOffice.org > 

Chemins)

• Modifier le format d'enregistrement par défaut et le délai d'auto-enregistrement (dans 

Chargement/Enregistrement  > Général)

3.3 La gestion des fichiers

 Créer un nouveau document 

 Dans OpenOffice.org comme dans Microsoft Office®, il existe différentes façons de créer de 

nouveaux fichiers. Une différence notable tient au fait que vous pouvez démarrer la création de  

n� importe quel type de fichiers OOo à partir de n� importe quelle application de la suite.

Par exemple, vous pouvez créer une feuille de calcul alors que vous êtes en train de travailler sous Writer.
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Pour créer un nouveau document aller dans le menu Fichier > Nouveau.

Ouvrir un document

Pour ouvrir un document aller dans le menu Fichier > Ouvrir.

Exporter un document en PDF et en XHTML

Chaque application a la possibilité d� exporter directement en PDF (Portable Document Format). Ce 
format standard de compression et de visualisation universelles est idéal pour envoyer un fichier devant 
être consulté dans Adobe Reader ou tout autre programme d� affichage de PDF, quel que  soit  le 
système d� exploitation.

Vous pouvez directement exporter un document au format  PDF en utilisant le bouton  de la  barre 

d� outils situé à gauche de l� icône Imprimante, ou en choisissant Fichier > Exporter au format PDF... 

Passer  par  le  menu permet  de  régler  certains  paramètres,  tels  que  la  qualité,  la  vue initiale  ou  la 
sécurité.

Pour  exporter  en  XHTML,  allez  dans  Fichier  >  Exporter... et  choisissez  XHTML dans  le  menu 

déroulant Format de fichier.
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Enregistrer Sous... 

Pour  enregistrer  un  fichier  dans  un  format  ou  dans  un  répertoire  différent,  allez  dans  Fichier  > 

Enregistrer sous... et sélectionnez un format dans la liste déroulante de Type de Fichier (Figure 1).

Protection par mot de passe

Pour empêcher la lecture de l� intégralité d� un document, une boîte à cocher  Enregistrer avec mot de  

passe dans la boîte de dialogue « Enregistrer sous » est disponible. Cette option n� est disponible que 
pour les fichiers enregistrés dans un format d'OpenOffice.org.

Formats d'enregistrement possibles avec Writer 

En plus de ses formats natifs (.odt et .ott), Writer peut enregistrer dans les formats suivants :

OpenOffice.org Writer 1.x (.sxw, .stw)

Microsoft Word® 97/2000/XP (.doc)

Microsoft Word® 95 (.doc)

Microsoft Word® 6.0 (.doc)

Microsoft Word® 2003 XML (.xml)

StarWriter 5.0 (.sdw)

StarWriter Template (.vor)

StarWriter 4.0 (.sdw)

StarWriter 4.0 Template (.vor)

StarWriter 3.0 (.sdw)
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Microsoft Pocket Word® (.psw)

DocBook (.xml)

AportisDoc (Palm) (.pdb)

Rich Text Format (.rtf)

StarWriter Template 3.0 (.vor)

Text (.txt)

Text Encoded (.txt)

HTML (.html, .htm)

Le  format  .rtf  est  généralement  utilisé  pour  transférer  des  fichiers  texte  entre  des 
applications, mais des pertes de mise en forme et d� images peuvent se produire quand le fichier est 
ouvert dans Microsoft Office®. Le meilleur moyen d� ouvrir un fichier Writer dans Microsoft Word® 
est d� enregistrer ce fichier en format Microsoft Word® 97/2000/XP (.doc).

Formats d'enregistrement possibles avec Calc 

En plus de ses  formats natifs (.ods et .ots), Calc peut enregistrer dans les formats suivants :

OpenOffice.org Calc 1.x (.sxc, .stc) Data Interchange Format (.dif)

Microsoft Excel® 97/2000/XP (.xls, .xlw) dBase (.dbf)

Microsoft Excel® 97/2000/XP Template (.xlt) SYLK (.slk)

Microsoft Excel® 95 (.xls, .xlw) Text CSV (.csv; .txt)

Microsoft Pocket Excel® (.pxl) Formats StarCalc (.sdc, .vor)

Microsoft Excel® 2003 XML (.xml) HTM and HTML files

Formats d'enregistrement possibles avec Impress

En plus de ses formats natifs (.odp et .otp), Impress peut  enregistrer dans les formats suivants :

Microsoft Powerpoint® 97/2000/XP (.ppt, .pps)

Microsoft Powerpoint® 97/2000/XP Template (.pot)

StarDraw, StarImpress (.sda, .sdd, .vor)

Impress peut aussi exporter vers MacroMedia Flash (.swf), ainsi que dans les différents formats de 
documents graphiques de Draw énumérés cidessous.
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Formats d'enregistrement possibles avec Draw

Draw ne peut enregistrer que dans ses formats natifs et en format StarDraw, mais il peut exporter en :

BMP

EMF

EPS

GIF

JPEG, JPG

MET

PBM

PCT

PGM

PNG

PPM

RAS

SVG

SVM

TIFF

WMF

XPM

Formats d'enregistrement possibles avec l'editeur HTML

Document HTML (.html, .htm)

OpenOffice.org 1.0 Modèle (.stw)

Modèle de document HTML (.oth)

StarWriter/Web 5.0 et 4.0 Modèle (.vor)

Texte (OpenOffice.org Writer/Web) (.txt)

Texte codé (OpenOffice.org Writer/Web) (.txt)

L'éditeur HTML peut également exporter un fichier texte au format  MediaWiki. Pour ce faire, allez 

dans le menu Fichier > Exporter... et choisissez MediaWiki.
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3.4 Deux eléments spécifiques à OpenOffice.Org 

Le navigateur

Pour la création de rapports et de notes complexes OpenOffice.org dispose d'un outil très performant 
dénommé le Navigateur.

Cet outil est comparable au mode lecture à l'écran ou Explorateur de documents de Word®.

Il s'en distingue nettement sur deux points :

• le navigateur est disponible dans tous les outils de la suite ;

• la richesse des fonctionnalités offertes.
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Sur ce dernier point, tout objet présent à l'intérieur d'un document peut servir de référence au 
navigateur. Il est donc possible de naviguer dans le document à partir des titres, des tableaux, des 
images, des objets OLE, etc. La liste des objets repérés se plie et se déplie selon le même mode qu'un 
Explorateur ainsi que le montre l'image ciaprès.

Le Navigateur peut être placé sur le bureau et déplacé comme une fenêtre. Il peut aussi être ancré à l'un 
quelconque des cotés du bureau selon la méthode décrite au paragraphe 2.1.4 Les fenêtre ancrables

Voici la présentation avec le navigateur ancré à gauche du bureau

L'affichage ou la fermeture de la fenêtre ancrée s'obtient en cliquant sur la flèche d'affichage.

La fenêtre peut être rendu flottante ou ancrée en cliquant sur le bouton . La fenêtre est flottante quand 
elle se superpose au document. Elle est ancrée quand le document est juxtaposé à la fenêtre et apparaît 
donc dans sa totalité.
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Le Navigateur se compose de trois parties :

• en partie haute, les icônes donnant accès aux fonctions

• en partie centrale, la partie navigation

• en partie basse une fenêtre d'affichage des documents ouverts

Le Navigateur est disponible avec des présentations et des fonctionnalités adaptées pour certaines 
fonctionnalités avancées de la suite OpenOffice.org telles les documents maître ou les 
formulaires.

Ces dispositifs avancés ne sont pas décrits ici. L'aide de OpenOffice.org fournit des 
informations complètes sur ces sujets.

Naviguer dans le document

Le Navigateur permet donc de se déplacer à l'intérieur d'un document. Chaque élément (titre, tableaux, 
feuille de calcul, plage de données) constituant votre document est référencé dans la fenêtre principale 
du navigateur. Un clic sur l'un d'entre eux positionne le curseur directement à son emplacement dans le 
document.

Pour des documents très complexes, vous pouvez souhaiter n'afficher que la rubrique dans laquelle vous 
voulez naviguer : par chapitre, par tableaux, par nom de plages... Pour cela, sélectionnez la rubrique 
concernée et cliquez sur l'icône Basculez l'affichage du contenu. Dans la fenêtre principale, ne 
s'afficheront que les éléments de cette rubrique.

Vous pouvez encore affiner votre navigation en indiquant les niveaux de titres à afficher. Cliquez sur 
l'icône correspondante dans la barre d'outils en haut de votre Navigateur et choisissez la profondeur de 
niveau à afficher en cliquant sur le numéro correspondant.

Atteindre d'autres documents

La liste déroulante située en bas du navigateur indique tous les documents OpenOffice.org ouverts et 
qui figurent dans la barre d'état de Windows. Pour atteindre facilement un point d'un de ces autres 
documents, sélectionnez son nom dans la liste déroulante. Son contenu (chapitres, tableaux...) 
s'affichera dans la fenêtre principale du Navigateur, sans pour autant qu'il s'ouvre à l'écran. Un double 
clic sur l'un des éléments dans cette fenêtre vous permettra de l'atteindre directement dans le document 
qui s'affichera alors sur votre écran.
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Organiser votre document

A l'aide du Navigateur vous avez également accès à des outils qui vous permettent d'organiser votre 
document, rappelant les fonctionnalités du mode plan.

Il vous est ainsi possible de déplacer un chapitre ou sous chapitre. Sélectionnez la partie à déplacer dans 
la fenêtre principale du Navigateur et cliquez ensuite sur l'icône chapitre vers le haut ou chapitre vers le 
bas. Autant de fois que nécessaire pour le déplacer à l'endroit voulu.

De la même manière vous pouvez hausser ou baisser les chapitres d'un ou plusieurs niveaux. Là encore, 
la fonction est accessible dans la barre d'outils sise en haut du Navigateur.

Certaines rubriques ont des fonctions particulières associées, notamment en ce qui concerne les 
tableaux.

Sélectionnez le nom d� un de vos tableaux dans la fenêtre principale du Navigateur. Faites un clic droit 
sur cette sélection pour en afficher le menu contextuel.

Tout en bas de ce menu, vous verrez une rubrique Tableau. A cet endroit vous aurez la possibilité 
d� éditer le formatage du tableau (sauf s� il est protégé), de le déprotéger (sauf s� il ne l� est pas), de le 
supprimer ou de le renommer.

Repères de texte, images, objets OLE, index, etc comportent un menu contextuel similaire.

La commande Supprimer l� index, supprimera l� index, mais laissera le contenu sous forme de texte, par 
exemple votre table des matières automatique deviendra un simple texte. De même que la commande 
En lecture seule de ce même menu contextuel protégera l� index contre toutes modifications.

Si des éléments sont masqués dans votre document (section, index, tableaux...), leur nom apparaîtra en 
grisé dans le Navigateur

Le Navigateur comporte également trois fonctions très intéressantes pour la mise en oeuvre de votre 
document : insérer comme lien, insérer comme une copie, insérer comme hyperlien

• insérer comme lien : dans le navigateur, cliquez sur l'élément (un sous-chapitre par exemple) 
que vous souhaitez insérer dans votre document, faites un clic droit pour afficher le menu 
contextuel. Choisissez le Mode glisser, puis insérer comme lien. Cliquez sur le sous-chapitre 
sélectionné dans le Navigateur et sans relâcher le bouton de la souris, glissez le dans votre 
document à l'endroit souhaité. Relâchez votre doigt, vous constatez qu'une section contenant 
l'ensemble du sous- chapitre s'est inséré dans votre document. Cette section est liée au sous-
chapitre que vous venez de copier. Ce qui signifie que si vous modifiez le sous-chapitre 
(source) dans votre document, le contenu de cette section contenant la copie sera également 
modifié.

Formation OpenOffice.org -- Moving Art Studio a.s.b.l.-- page 25



• Insérer comme une copie : suivant l'exemple du sous-chapitre utilisé cidessus, dans le menu 
contextuel, cette fois-ci choisissez insérer comme une copie. De la même manière faites glisser 
le sous-chapitre choisi dans votre texte, une section se crée contenant également le contenu du 
sous chapitre, mais cette fois, aucun lien avec la source, si vous la modifiez, le contenu de la 
section n'en sera pas affecté. 

• Insérer comme hyperlien : à partir du même sous-chapitre, faites un clic droit dans le menu 
contextuel et choisissez insérer comme hyperlien. Glissez le sous chapitre choisi dans votre 
document : un hyperlien renvoyant au sous chapitre choisi s'insère. Cette méthode est très 
pratique pour faire des tables des matières dans les documents HTML ou des renvois entre 
chapitres. 

Vous pouvez également modifier le Mode Glisser à partir de la barre d� outils du Navigateur en cliquant 
un peu longuement sur l� icône et en sélectionnant le mode voulu.

Ce mode fonctionne également entre documents. Comme nous l� avons vu plus haut, il vous est possible 
d� afficher le contenu d� un document non actif à l� écran (ouvert dans la barre d� état de Windows) dans 
la fenêtre principale du Navigateur. Vous pouvez ainsi sélectionner chapitre, feuille de calcul, ou tout 
autre élément dans ce document et l� insérer en Mode Glisser dans le document sur lequel vous êtes 
entrain de travailler. Suivant l� élément dont il s� agit, tous les modes ne sont pas disponibles.

Sous Calc, le Navigateur vous permet de mettre en oeuvre vos Scénarios, de les 
démarrer, les renommer...

Sous Impress, vous avez la possibilité de l'afficher lors de la présentation, vous 
permettant ainsi d'intervenir en modification sur les objets.

Le styliste

Dans le même esprit que le Navigateur OpenOffice.org dispose d'un outil dénommé Styliste pour l'aide 
à la rédaction, à la réalisation et à la mise en forme de documents. Cet outil permet d'afficher tous les 
styles et de les apposer très rapidement et simplement à l'objet désigné.

L'approche suivie par OpenOffice.org est de recommander l'utilisation de style pour la confection des 
documents (texte classeur, présentation, etc.). Pour certaines fonctionnalités, cette approche est même 
obligatoire. Ainsi une mise en page spécifique dans le tableur ne sera conservée et donc retrouvée à 
l'ouverture suivante que si un style de page a été défini.
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De même, il est possible de définir des styles pour chacun des objets manipulés dans la suite.

Le styliste est donc disponible dans toutes les composantes de la suite.

Bien entendu les commandes de la suite pour la création et la modification des styles sont disponibles 
dans les menus et commandes ainsi que dans les menus contextuels.

Le styliste dispose d'une fonction permettant de recopier le style actif. Il faut ouvrir le Styliste et 
sélectionner le mode Remplir Tout ou verseuse. On recopie le style actif en positionnant le curseur sur 
le paragraphe et en cliquant sur le bouton de la souris. Pour copier un style sur des caractères, il faut 
auparavant les sélectionner. 

Le Styliste est l'outil de OpenOffice.org qui facilite et organise la gestion des styles et leur mise en 
application. 

La fenêtre du Styliste est affichée par la commande Format>Styliste, l'icône  ou, la touche F11 

Cette fenêtre  peut être utilisée comme une palette que l'on peut déplacer sur l'écran avec la souris. Elle 
peut être réduite ou fermée avec les outils classiques.

Le Styliste peut aussi être ancré sur l'une quelconque des bordures de l'espace de travail
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Vous pouvez à partir de ce Styliste déterminer à l'avance tous les styles de votre document. Un clic droit 
sur le style choisit vous permet de le modifier selon votre choix. Une fois le style modifié, un double 
clic sur celuici et il est alors appliqué à l'endroit souhaité dans le document.

La liste déroulante en bas du Styliste, vous laisse le choix d'affichage des styles voulus : uniquement 
ceux que vous avez personnalisés, uniquement ceux déjà utilisés dans le document... 

3.5 Nos habitudes d'utilisation...

La véritable question que se posent les utilisateurs de la suite bureautique Microsoft Office® est de 
savoir si, vraiment, cette fameuse suite libre qu'est OpenOffice.org 2.3, est en capacité d'égaler sa 
concurrente payante.

Nous allons tâcher de répondre à cette question critique qui, en effet, conditionnera le succès ou l'échec 
de cette suite auprès des utilisateurs.

Il apparaît toutefois délicat de dresser une liste des défauts ou problèmes du traitement de texte Writer 
par rapport à Word® 2003 tant cela peut-être lié à nos habitudes d'utilisateurs. Il n'empêche que 
certains utilisateurs de Word® se plaignent de certains manques dans Writer que nous allons vous 
présenter.

Impression générale

De prime abord, lorsque l'on utilise Writer, on retrouve bien l' "esprit" d'Office et de Word® en 
particulier. Comme nous vous l'avons indiqué précédemment, les utilisateurs novices ne seront pas 
perdus, de même que les connaisseurs s'y retrouveront facilement tant toutes les fonctions de base sont 
similaires entre les deux logiciels.

Cependant, pour les utilisateurs les plus avancés et experts, Writer semble encore trop limité face à 
Word®. Ainsi, certaines fonctions ne sont pas encore au niveau de celles proposées par Word®, alors 
que d'autres manquent cruellement à l'appel.

En ce qui concerne le confort à l'utilisation, même s'il est très satisfaisant pour l'utilisateur lambda, il 
diminue nettement lorsque l'on pousse Writer dans ses derniers retranchements. Il reste ainsi plus lent 
que Word® au démarrage, à l'utilisation, et à l'enregistrement des documents. Et même si l'option de 
préchargement fonctionne bien, Word® reste le plus rapide.
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Avantage par contre à OpenOffice.org 2.3 au niveau de l'installation, cette dernière est plus légère et 
moins tentaculaire que celle d' Office. On peut ainsi citer l'absence de DLL dans tous les coins et de 
clés de registre à foison.

Les menus contextuels

De plus, en raison de l'intégration des modules, les menus ainsi que les barres d'objets et d'instruments 
sont contextuels en fonction du type d'action en cours dans le document. 

En particulier, la barre d'objets sera totalement différente selon que le curseur se situe dans du texte, 
dans un tableau, sur une image, sur un graphique, sur un dessin. Ainsi à partir d'une présentation qui 
paraît homogène, des fonctionnalités apparaissent ou disparaissent.

De même les menus seront différents selon que le curseur est placé dans du texte, un tableau, sur une 
image, des puces, un objet,...

En cas de doute sur l'action engagée par le clic sur une icône, le survol prolongé de cette icône par le 
curseur entraîne l'affichage d'une bulle décrivant la fonction sous-jascente. 

L'ensemble des actions présentées au travers de ces menus sont aussi disponibles dans des menus 
contextuels.

Pour connaître la liste des actions disponibles sur un objet quelconque (tableau, image, graphique, mot), 
un clic sur le bouton droit de la souris déclenche l'apparition d'un menu adapté à la situation.

Voici l'exemple d'un menu contextuel affiché par un clic sur le bouton droit de la souris, le curseur étant 
placé dans le tableau

Les icônes déployables

En observant les différentes barres, on constate que certaines icônes comportent dans leur coin haut 
droit, un petit triangle vert.

Le présence de ce triangle vert indique la présence de choix multiples sous cette icône. Ces choix se 
déploient dans une barre complémentaire d'actions lors d'un clic prolongé sur l'icône.

On peut choisir l'action voulue dans le choix présenté.

De plus, certaines barres d'actions ainsi déployées comportent une barre de titre dont la présence 
indique que ces barres sont détachables. On peut les déplacer par glisser /déposer en pointant la barre 
de titre avec le bouton droit de la souris.

L'image cidessous montre un exemple de ces déploiements.
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Les fenêtres ancrables

Certaines fenêtres de OpenOffice.org sont des fenêtres ancrables, telles que le Styliste, le Navigateur ou 
la Gallery. 

L'utilisation du Styliste et du Navigateur est  décrite dans les chapitres suivants.

Ces fenêtres, peuvent être déplacées, modifiées en taille ou ancrées à une marge. Sur chaque bordure, 
vous pouvez ancrer plusieurs fenêtres en les empilant ou en les juxtaposant ; vous pouvez ensuite 
modifier la part relative de la fenêtre en décalant les lignes de délimitation à l'aide de la souris.

Pour désactiver puis réactiver l'ancrage, double-cliquez sur la fenêtre en maintenant la touche (Ctrl) 
enfoncée. Double-cliquez de cette manière sur une zone vierge de la fenêtre ; dans le Styliste, double-
cliquez sur une zone grisée de la fenêtre, par exemple, à côté des icônes.

Pour le Navigateur, cette présentation ancrée est tout à fait comparable au mode Affichage>Lecture à 
l'écran de MS Word®. Toutefois, ainsi que vous le verrez au chapitre qui lui est consacré, le Navigateur 
est un outil beaucoup plus performant que le mode lecture à l'écran.

L'affichage ou la fermeture de la fenêtre ancrée s'obtient en cliquant sur la flèche d'affichage.

La fenêtre peut être rendue flottante ou ancrée en cliquant sur le bouton. La fenêtre est flottante quand 
elle se superpose au document. Elle est ancrée quand le document est juxtaposé à la fenêtre et apparaît 
donc dans sa totalité.

Personnalisation des barres

Chaque barre peut être personnalisée soit au moyen du menu Outils>Adaptation soit par un clic droit 
dans la partie vide de la barre concernée.

Dans ce dernier cas, le menu contextuel fait apparaître, en première partie de liste, les barres affichées 

En seconde partie du menu contextuel apparaissent les choix :

• « Boutons visibles » qui permet de fixer la liste de boutons affichés. 

• « Adaptation » qui renvoie à la boîte de dialogue du menu Outils Adaptation

• « Personnaliser » qui affiche directement le choix Personnaliser de la boite de dialogue 
Adaptation

Le choix boutons visibles permet d'afficher la liste prédéfinie des icônes qui peuvent être affichées. Un 
simple clic du bouton gauche sur la ligne correspondante entraîne ou supprime l'affichage du bouton 
dans la barre.
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Il est possible d'ajouter des commandes à cette liste par le choix Personnaliser. 

Pour cela, dans la boite de dialogue Personnalisation des barres d'outils,

•  sélectionner une catégorie et une fonction. 

• en partie haute de la boîte de dialogue, le bouton correspondant est activé ;

• déposer ce bouton par glisser déposer sur l'emplacement voulu de la barre d'outils. 

On remarquera que les boutons peuvent être des textes au lieu d'icône.

Voici un exemple de personnalisation de la barre d'instruments

Rafraîchir l'écran

Dans certaines configurations, et en particulier lorsque l'on crée ou modifie des tableaux, on constate 
que certaines lignes ou caractères ne sont plus ou mal affichés. Cela est dû à un défaut de 
rafraîchissement de l'écran par Windows.

Deux méthodes peuvent être employées pour forcer Windows à rafraîchir l'écran :

• Monter ou descendre l'ascenseur, pour masquer et ré-afficher les éléments mal affichés

• Faire Ctrl+Maj+R.

Les commandes courantes

Dans ce chapitre, sont présentées les commandes courantes des deux suites.

Il s'agit des commandes communes aux différentes composantes des deux suites pour la manipulation 
des fichiers, l'affichage, le copier coller, l'orthographe, etc .

Ces commandes étant utilisées dans tous les outils, elles ne seront pas répétées dans les parties 
consacrées à l'étude comparative de chacune des fonctions des suites.

Sauf variation mineure et occasionnelle, le principe retenu est de prendre appui sur les menus des outils 
de MS Office® et de décliner les menus correspondants de OpenOffice.Org.

MS Office® OpenOffice.org 

Commande menu Clavier Menu Clavier

Fichier Nouveau

Ouvrir

Fermer

Enregistrer

Ctrl N

Ctrl O

Ctrl S

Fichier Nouveau

Ouvrir

Fermer

Enregistrer

Ctrl N

Ctrl O

Ctrl S
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MS Office® OpenOffice.org 

Enregistrer sous

Mise en Page

Aperçu avant Impression

(propriétés de Fichier Imprimer)

Fichier Imprimer Ctrl P

Enregistrer sous

Format Page

Fichier Aperçu avant impression

Configuration de l'impr.

Imprimer Ctrl P

Édition Annuler
Répéter
Couper
Copier
Coller
Rechercher
Remplacer

Édition Atteindre

Ctrl Z
Ctrl Y
Ctrl X
Ctrl C
Ctrl V
Ctrl F
Ctrl H
Ctrl B

Édition Annuler
Répéter
Couper
Copier
Coller

(1) Rechercher et remplacer

Édition Navigateur

Ctrl Z

Ctrl X
Ctrl C
Ctrl V
Ctrl F

F5

Affichage Page
Zoom
Plein écran

Affichage Zoom (Page)
Zoom
Plein écran Ctrl Maj J

Outil Orthographe
Correction automatique

Outil Macros
Personnaliser
Options

Outil Orthographe (2)
Vérification automatique
Macros
Adaptation
Options

Fenêtre Nouvelle Fenêtre Fenêtre Nouvelle Fenêtre (3)

(1) le remplacement des caractères génériques n'est pas opérationnel dans la version actuelle de OpenOffice.org (marques de 
paragraphes, retour chariot, tabulations).

(2) OpenOffice.org n'a pas de correcteur grammatical.

(3) Dans la suite OpenOffice.org, l'ouverture d'une fenêtre s'entend comme une nouvelle instance de document et donc 
entraîne l'apparition d'une nouvelle tâche dans la barre de tâches de Windows ; le partage d'écran, le dimensionnement se 
règle donc au moyen des outils de Windows et non par des commandes internes à la suite. (voir chapitre 1-3).
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La fonction de mise en page

Dans OpenOffice.org, la mise en page des documents ne répond pas à la même logique que dans 
MS Office®. 
Dans MS Office®, la mise en page s'applique au document ou à une section ou à partir d'un 
certain point.
En revanche, dans OpenOffice.org la mise en page est attachée au style de page. A chaque page 
est attaché un style de page (par défaut Standard). C'est d'ailleurs ce que l'on constate dans 
l'intitulé de la boîte de dialogue de la commande Format>Page.
La conséquence de cette orientation, c'est que la modification du style de page Standard (par 
exemple) par la commande Format>Page va s'appliquer à toutes les pages de styles Standard. 
Plus généralement, votre mise en page sera modifiée pour toutes les pages de même style que 
celle en cours, chaque fois que vous interviendrez dans Format>Page 

Profitez de la souplesse de gestion des formats de page apportée par OpenOffice.org.
Créez un style de page approprié pour la mise en page voulue (portrait, paysage, hauteur, marges, 
...) et appliquez-les en tant que de besoin.
Le chapitre sur les styles vous précisera la marche à suivre.

La vérification automatique de l'orthographe

La vérification automatique de l'orthographe s'obtient en sélectionnant la commande 

Outils>Orthographe>Vérification automatique ou en activant l'icône  de la barre 
d'instruments. Les mots erronés sont alors soulignés en rouge. 
Un clic droit de la souris sur le mot souligné vous propose la liste de mots de remplacement du 
dictionnaire dans le menu contextuel. Sélectionnez une suggestion de correction pour remplacer 
le mot erroné.

Le correcteur orthographique détecte les mots absents du dictionnaire mais ne sait pas proposer 
une suggestion de correction pour les mots comportant plus d'une faute.

Enregistrement après impression

OpenOffice.org demande systématiquement d'enregistrer un document après son impression 
même s'il n'a pas été modifié. 
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Pour supprimer cette option,
• Outils>Options>OpenOffice.org>Général
• dans la Rubrique Statut du document, décocher le case Impression : statut du doc....
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4. LE TRAITEMENT DE TEXTE �  COMPARATIF : WORD® - WRITER

Les tableaux ciaprès recensent une grande partie des fonctionnalités spécifiques aux outils de 
traitement de texte de chaque suite et les commandes correspondantes de menu ou de raccourci clavier.

Sont détaillées dans le premier tableau les commandes courantes utilisées par un agent dans l'exercice 
de fonctions de rédaction de lettres, textes courts ou note de présentation

Les tableaux suivants détaillent les fonctionnalités complètes pour la réalisation de tableaux et de 
publipostage.

4.1 Commandes pour la réalisation de textes simples (lettres, notes, fiches)

Le tableau ciaprès détaille les commandes comparées des deux suites pour la réalisation de textes 
simples.

MS Word® OpenOffice.org  Texte

Menu Clavier Menu Clavier

Édition Sélectionner tout Ctrl A Édition Sélectionner tout Ctrl A

Affichage Normal
Lecture à l'écran
Explorateur de documents

Affichage Mise en page en ligne
Édition Navigateur F5

Insertion Saut
Date et heure
Numéro de page
Champ
Caractères spéciaux
Note

/Note de bas de page
Note

/Note de fin de page
En tête
Pied de page

Insertion Saut manuel
Champ/Date/heure
Champ/Numéro de page
Champ/Autres
Caractères spéciaux
Note de bas de Page

/Note de bas de page
Note de bas de page

/Note de fin
En tête
Pied de page

Format Police
Paragraphes

Format Caractères
Paragraphes
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La mise en forme de caractères

La commande Format>Caractères affiche une boîte de dialogue comportant plusieurs onglets.
L'onglet Police permet de choisir la police de caractères, d'en régler le style, la taille, et la 
couleur.
Pour appliquer, les « attributs » de MS Word®, il faut passer par l'onglet Effets de caractères. 

La gestion des en-têtes et des pieds de page

Dans OpenOffice.org les en-têtes et pieds de page sont liés au style de page. Leur gestion est 
donc sensiblement différente que dans MS Word®. Pour l'exemple, nous prendrons les pieds de 
page.
La commande Insertion>Pied de page ne se présente pas du tout comme dans MS Word®. Vous 
voyez en effet que sur le menu s'affiche la liste des styles de page utilisés dans votre document. 
Vous pouvez activer ou désactiver le pied de page en cochant ou décochant le style de page. 
Pour plus de paramétrage il vous faudra passer par la procédure de modification des styles de 
pages. Cette procédure est décrite dans le chapitre consacré aux styles dans OpenOffice.org

Vous devrez insérez les informations que vous voulez voir répéter sur les pages de votre 
document, dans chaque pied de page correspondant à un style de page différent 

4.2 Insertion d'images ou d'objets

A ces commandes peuvent être ajoutées celles nécessaires à l'insertion d'images et d'objets dans un 
texte simple pour l'incorporation de logos ou d'images.

MS Word® OpenOffice Texte

Insertion Images
Images de la bibliothèque

Insertion Images
A partir du fichier

Insertion Objet

Outils Gallery

Insertion Images
A partir d'un fichier

Insertion Objet
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WordArt® – FontWork 

Dans OpenOffice.Org, il existe un outil similaire à WordArt® de Microsoft Office® qui s'appelle 
FrontWork. 

Pour le lancer, soit aller sur Afficher > Barres d'outils > Drawing ou cliquer sur l'icone   
(Fonctions Draw) de la barre d'outils � Normale�  à droite de l'icone de création des tableaux.  
La barre d'outils 'Draw' apparait alors en bas de page. 

Cliquer sur l'icone          et la fenêtre FrontWork apparait: 

Question souvent entendue : où peut-on trouver des clip art libres de droits pour OpenOffice.org ou 
telle autres application ?
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La galerie

La gallerie contient tous les média digitaux (donc aussi les ClipArt) classés par thème. Pour l'afficher aller dans 

Outils  > Gallerie ou cliquer sur l'icône  de la barre d'outils normale. 

Open Clip Art Library 

Il s'agit d'un projet qui a justement pour objectif de regrouper des cliparts librement utilisables par tous et toutes 
(puisque sous licence Creative Commons Domaine Public).

Vous pouvez soumettre rapidement vos créations (la qualité est cependant recherchée) grâce au formulaire 
présent sur la page d� accueil (en anglais). Pour vos création, préférez un format vectoriel (voir Appendix B)
L� initiative est à saluer et bien que la qualité des images soit inégale il serait surprenant que vous ne trouviez pas 
votre bonheur dans les quelques 7000 cliparts déjà disponibles. Une interface de recherche est disponible sur la 
page d� accueil du site (rentrez vos mots clés en anglais). 

Intégration avec OpenOffice.org

En tout cas, les cliparts peuvent très bien s’intégrer avec OpenOffice.org après quelques manipulations 
répétitives si l’on veut intégrer les 7000 images d’un coup. L’idéal aurait été de pouvoir intégrer directement les 
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images d’Open Clip Art Library au format vectoriel svg... mais ce n’est pas encore possible. Il existe bien un 
addon pour qu’OpenOffice2 supporte le svg, mais celuici semble marcher imparfaitement. On pourrait aussi 
convertir les svg au format wmf, format vectoriel de l’éditeur célèbre Inkscape et reconnu par OpenOffice. Ca fait 
quand même un peu mal de convertir un format libre en un format propriétaire... pour que celuici fonctionne 
dans un logiciel libre. 

Comment fait­on alors pour importer les images dans la gallery d’OpenOffice ? 

L’archive est classée par catégories et propose pour chaque clipart un fichier texte (pour les infos sur l’image ­ 
en anglais ­, son auteur et la licence), un fichier .png (pour le web) et surtout un fichier .svg (vectoriel, le format 
qui permet la manipulation). 

La solution la plus pédagogique consiste à créer son propre thème de gallery (Dans OpenOffice, cliquez sur la 
gallerie puis "nouveau thème" et indiquez son nom, par exemple "animaux") et importez les images se trouvant 
dans le dossier "animals" que vous aurez télélargé depuis le site d’Open Clip Art Library. Recommencez 
l’opération en créant d’autres thèmes pour votre galerie... et oui, c’est peu long quand même... 

L’inconvénient de cette solution, c’est que l’on se sert des fichiers au format png (format non vectoriel) contenu 
dans l’archive d’Open Clip Art Library, or ceux­ci ont une taille de 50 à 100 pixels de large en moyenne. C’est un 
peu petit, lorsqu’on voudra agrandir dans OpenOffice, on aura automatiquement des effets disgracieux. (voir 
Appendix B pour plus d'informations sur l'installation de la bibliothèque OpenClipart et sur les différents formats 
d'images utilisés).

Obtenir une image ou objet stable

Quand on insère un objet, un graphique ou une image, il est souvent difficile de bien les 
positionner sur la page sans que leur position soit changée par une modification ultérieure du 
document
Voici l'une des manières qui permet d'obtenir une très bonne stabilité :
• Ancrez l'image ou l'objet comme caractère (menu contextuel sur l'image). Ainsi il est 

considéré comme un caractère de paragraphe, ce qui est très stable,
• Créez un style de paragraphe qui respecte la mise en page souhaitée pour vos images ou 

objets. Surtout, n'oubliez pas les écarts avant ou après qui feront que votre image ne 
chevauchera jamais les textes adjacents,

• Appliquez ce style, en faisant bien attention de sélectionner le paragraphe et non l'image ou 
l'objet.

Créer une image composite 

Il peut être utile d'ajouter des informations ou commentaires à une image ou un graphique, au 
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Créer une image composite 

moyen de bulle de texte par exemple.
Dans ce cas, pour obtenir une image stable, procédez de la manière suivante :
• Composez votre image avec la barre de dessin dans le traitement de texte ;
• Copiez tous ces éléments dans l'outil de dessin ;
• Groupez tous ces éléments 
• Exportez l'image au format JPEG par la commande Fichier>Exporter et insérez l'image 

obtenue dans le traitement de texte

On peut aussi après avoir groupé les éléments, les incorporer au texte par copier/coller. Dans ce 
cas, le problème est que l'on n'insère plus une image mais un « support de travail » qui ne peut 
être reconnu comme image et donc servir de référence dans le navigateur.
Il semble aussi que dans ce cas la stabilité du document ne soit pas certaine.

4.3 Vérificateur orthographique

Pour activer la correction orthographique automatique cliquer sur l'icône   de la barre d'outils 
normale. 

Pour modifier les paramètres du correcteur, aller dans le menu Outils > Options > Paramètres 
Linguistiques > Linguistique. Vous pouvez aussi ajouter un nouveau dictionnaire via le paramètre 
dictionnaire défini par l'utilisateur. 

Pour installer un nouveau dictionnaire, aller dans le menu Fichier > Assistants  > Installer de nouveaux 
dictionnaires... et cliquer sur le lien adéquat.
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4.4 Commandes pour la création de tableaux

Un tableau peut être créé en utilisant les 
fonctionnalités suivantes :

• la commande Insertion>Tableau

• la combinaison de touches Ctrl+F12

• l'icône déployable Insérer, située en tête 
de la barre d'instruments

Chacune de ces commandes appelle l'affichage de 
la boîte de dialogue ciaprès.

Cette boîte de dialogue vous permet de configurer votre tableau selon votre convenance.

Le bouton Autoformat met à votre disposition des modèles de tableaux prédéfinis.

Il peut être très intéressant de nommer le tableau d'un nom significatif. En effet, ce nom apparaîtra dans 
la liste des tableaux affichés par le Navigateur. Si vous rédigez un texte comportant plusieurs tableaux, 
il vous sera ainsi facile de les reconnaître et de les atteindre directement. 

Ces fonctionnalités du Navigateur sont expliquées au chapitre spécifique.

Le tableau ciaprès récapitule les principales commandes utilisables. Certaines de ces fonctions sont 
disponibles par le menu contextuel.

MS Word® OpenOffice.org Texte

TableauInsérer un tableau
Sélectionner le tableau
Trier 
Formule
Scinder le tableau
Convertir tableau en texte
Format automatique de tableau

Insérer Tableau
(icône de la barre d'objets)
Outil Trier
Barre de calcul (touche F2)
Format Scinder le tableau

Texte<->Tableau
Autoformat

TableauInsérer des lignes
Supprimer des lignes
Sélectionner la ligne
Uniformiser la hauteur des lignes

Format Ligne/Insérer
Ligne/Supprimer
Ligne/Sélectionner
Ligne/Hauteur

TableauInsérer des colonnes Format Colonne/Insérer
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MS Word® OpenOffice.org Texte

Supprimer des colonnes
Sélectionner la colonne
Uniformiser la largeur des colonnes

Colonne /Supprimer
Colonne /Sélectionner
Colonnes/Largeur optimale

TableauFusionner les cellules
Fractionner les cellules

Format Cellule/Fusionner
Cellule/Fractionner

Gérer l'écart entre la bordure des cellules et le texte

Dans MS Word® l'écart entre les bordures de cellules et le contenu est géré au moyen de la 
commande Format>Paragraphe. 
Dans OpenOffice.org cette commande est inopérante pour les bordures hautes et basses. En 
revanche, on peut contrôler les écarts à droite et à gauche par la commande Format>Paragraphe, 
ce qui paraît normal car l'alignement des paragraphes peut varier dans une même cellule.
Pour gérer l'écart entre la bordure et le contenu, il faut utiliser la commande Format>Tableau 
Onglet Bordure.
La rubrique « Écart avec le contenu » permet de faire varier cet écart soit de manière 
synchronisée, soit indépendamment pour le haut, le bas, droite ou gauche.
Pour obtenir des écarts différents selon les cellules, lignes, colonnes sélectionner d'abord les 
cellules, lignes, colonnes.

Attention, si vous devez modifier un élément s'appliquant à l'ensemble du tableau (trait de 
bordure par exemple), c'est l'écart standard qui s'appliquera à toutes les cellules. Les écarts 
précédemment spécifiés seront tous annulés.

Les écarts entre bordure et contenu sont perdus lors de l'enregistrement au format MS Word®.

Modifier la largeur de colonnes

La largeur de colonnes se modifie aisément avec la souris.
Cependant, dans les tableaux complexes comportant des cellules fusionnées ou scindées, il arrive 
que se produisent des blocages.
Dans ce cas, l'onglet Colonnes de la boîte de dialogue Tableau permet de gérer très facilement les 
largeurs de colonnes (Accès par le menu Format Tableau ou menu contextuel Tableau)
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Insérer un paragraphe en début de page devant un tableau

Insertion d'un texte au début d'un document texte, devant un tableau inséré ou directement après 
un saut de page fixe :
1. Placez le curseur dans la première cellule du tableau au tout début du contenu de cette cellule.
2. Appuyez sur la touche Entrée.

Calculer dans un  tableau

Il est très facile d'introduire des formules de calcul dans un tableau de traitement de texte. Un 
tableau est considéré comme dans le tableur comme un ensemble de cellules numérotées, qui 
sont donc adressables dans les mêmes conditions. De la même manière que  dans le tableur, 
l'inclusion des noms de cellules dans les formules est obtenu dynamiquement en portant le 
curseur dans la cellule.
Pour cela, après avoir placé le curseur dans une cellule, appuyer sur la touche F2 ou saisir le 
signe =, une barre de calcul apparaît à la place de la barre d'objets. Un clic sur le signe  de la 
barre d'objets ouvre la barre de calcul avec la fonction « somme » présélectionnée.

La première icône  de la barre de calcul donne accès à une liste de fonctions de calcul.
Pour modifier une formule, se positionner dans une cellule et appuyez sur F2. Modifier la 
formule dans la barre de calcul.
Il est possible d'effectuer des calculs entre plusieurs tableaux d'un même texte.

4.5 Création et gestion de modèles et de styles

Dès lors que l'on rédige un rapport ou des documents comportant des mises en page compliquées, 
l'utilisation de commandes de styles s'impose. 

Toutefois dans OpenOffice.org, il est recommandé d'utiliser les commandes de styles et d'éviter les 
surcharges des styles prédéfinis au moyen des commandes mises en forme (caractères, paragraphes, ...), 
en particulier si le document doit être convertit dans un autre format.

Ci après le tableau comparatif des divers menus à utiliser. 

MS Word® OpenOffice.org  Texte

Format Style/Nouveau
Style/Modifier

Format Style/Catalogue/Nouveau
Style/Catalogue/Modifier
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MS Word® OpenOffice.org  Texte

Style/Supprimer
Style/Organiser

Style/Catalogue/Supprimer
Style/Catalogue/Gérer

Dans OpenOffice.org , les fonctions de styles sont disponibles sur les caractères, les paragraphes, les 
pages, la numérotation, les cadres.

Plusieurs commandes sont disponibles pour appliquer un style prédéfini :

• le menu Format/Style/Catalogue, sélectionner la catégorie de style, puis double clic sur le style 
choisi ;

• dans la liste des derniers styles utilisés, double clic sur le style choisi ;

• activation du Styliste par la commande Format>Styliste, l'icône  ou la touche F11 puis 
double clic sur le style choisi ;

• le mode « Remplir tout »ou Verseuse  disponible dans le Styliste qui recopie le style 
sélectionné

L'image ciaprès présente les différents modes d'accès aux fonctions de styles :
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Appliquer les styles avec la Verseuse 

Le traitement de texte MS Word® dispose d'un outil dénommé « Pinceau » permettant de 
recopier des attributs de mise en forme de texte.
Dans OpenOffice.org, c'est la Verseuse qui se charge de cette fonction.
Sélectionner un style (de page, de caractère, de paragraphe, ...) dans le Styliste. Cliquer sur la 

Verseuse . 
Cliquer sur les éléments auxquels le style doit être appliqué. Répéter l'opération autant de fois 
que souhaité. Cliquer sur la verseuse pour annuler son action.

La Verseuse ne recopie que des styles déjà définis. OpenOffice.org ne fait pas de barbouillages.
Conçu pour une utilisation privilégiée des styles, OpenOffice.org fonctionne mieux si l'on ne 
surcharge pas les styles existants par les fonctions de Format Paragraphe ou Caractères.

Créer ou modifier un style

On peut créer un style ou modifier un style existant par la commande menu Format>Style>Catalogue 
bouton Nouveau ou Modifier.

Toutefois, il est souvent plus simple d'utiliser le Styliste. Dans ce cas, le menu contextuel affiché par un 
clic sur le bouton droit de la souris présente les choix Nouveau, Modifier, Supprimer.

Quel que soit le mode d'accès, la même boîte de dialogue s'affiche correspondant au type de style que 
vous souhaitez créez ou modifier

Pour créer un nouveau style, procéder de la manière suivante :

• Dans la boîte de dialogue de la commande Format>Styles>Catalogue ou dans le Styliste, 
sélectionner le type de style à créer (paragraphe, caractères, page, ...) et choisir Nouveau

• Dans l'onglet Gérer, donner un nom au style

• Si besoin est, positionner les styles de suite, la liaison à un autre style, le classement en 
catégorie

Les liaisons entre styles

Pour les styles de paragraphe et de caractères OpenOffice.org propose de lier les nouveaux styles 
avec un style existant.
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Le nouveau style hérite de fait de toutes les caractéristiques du style lié, qui seront remplacées 
pour certaines par celles qui seront spécifiques aux nouveaux styles.
Les caractéristiques non modifiées sont donc directement liées au style de base

En conséquence, une modification des caractéristiques du style de base pourra être répercutée de 
proche en proche dans les styles héritiers.

Classement des styles de paragraphe

Lorsque l'on crée un nouveau style de paragraphes, OpenOffice.org propose de le classer dans 
une catégorie par défaut.
Il peut être intéressant de changer ce classement notamment si vous désirez que tous vos styles 
soient classés dans la catégorie Styles personnalisés. Ce classement peut être très pratique pour la 
mise en oeuvre de vos styles avec le styliste.
Pour cela, lors de la création ou de la modification, passez par l'onglet Gérer et choisissez votre 
catégorie. 

Supprimer des styles 

Le menu contextuel du Styliste ou la commande Format>Styles>Catalogue affichent un choix 
Supprimer.
Notez que ce choix n'est actif que pour les styles que vous avez créés. Il est impossible de 
supprimer les styles proposés par OpenOffice.org en standard.
Lorsque l'on veut supprimer un style, la suite indique si le style est utilisé avant toute 
suppression.
Pour rechercher les emplacements où un style est utilisé, employez la commande Édi-
tion>Rechercher et Remplacer qui comporte une option de recherche par les styles 

Les styles de page

Pour gérer la mise en page des documents, OpenOffice.org introduit la notion de style de page. Cette 
notion se substitue à celle de section dans MS Word®.

Elle permet une gestion beaucoup plus fine de la mise en page puisque l'on peut créer autant de styles 
de page que de besoin (Première page, page de sommaire, paysage, etc). Outre les paramètres classiques 
de taille et de marge, le style de page permet de définir la présence d'en-tête et de pied de page, de 
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colonnes, de bordure, etc.

Le format de page Standard

La commande Format>Page agit directement sur le style de page courant. 
Une modification par cette commande sera répercutée sur toutes les pages de même style
Si vous voulez utiliser votre propre style de page, créez un style « Page courante » qui vous soit 
propre plutôt que de surcharger le style « standard »

Insérer une page au format paysage

Par l'une des méthodes décrites en début de § 5.1.3., créer un style de page « Paysage ». Ne pas 
oublier de mettre en style de suite le style utilisé pour les pages normales
Dans l'onglet « Page » de la boîte de dialogue « Style de Page » choisir orientation « Paysage »
Pour insérer une page de style « Paysage », placer le curseur en fin de page, par la commande 
Insertion>Saut manuel>Saut de page, dans la liste déroulante « Style » choisir Paysage 
Il est également possible de changer le style d'une page. Pour cela, placer le curseur dans la page 
et appliquer le style voulu, soit par le Styliste, soit par la commande Format>Style>Catalogue.
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Page portrait �  paysage dans le même document.

Un document avec une première page différente

OpenOffice.org propose un style de page « Première Page ». Dans l'onglet Gérer on voit que le style 
de suite est « Standard ». Le modifier si l'on a créé son propre style de page courante.
Modifier le style « Première page » en activant l'en-tête de page (Onglet En-tête). Modifier 
éventuellement les paramètres d'écart et de position.
Sur le document vierge appliquer le style de page « Première page »
• Saisir le texte, insérer un logo ou une image dans l'en-tête par exemple 
• En fin de texte, passer à la page suivante soit par 'Ctrl+Entrée' soit par Insertion>Saut 

manuel>Saut de page
• la seconde page prend le style « standard » donc sans logo ni en-tête de page
On peut bien entendu faire la même opération pour les pieds de page.
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Commencer une numérotation de page en page 2

Il est parfois intéressant de ne commencer la numérotation des pages que sur la page 2. Pour 
cela :
• Appliquer à la première page, le style « Première page » sans insérer de numéro de page (il 

peut y avoir ou non un pied de page)
• Dans le style de page « Standard », activer le pied de page afin de pouvoir y insérer la 

numérotation 
• dans le pied de page de la page 2, insérer le champ « numéro de page »

La conversion des en-têtes et pieds de page

La gestion des en-têtes et des pieds de page par le moyen des styles de page est très efficace sur 
le plan de la conception des documents. Elle a cependant des effets pervers sur la portabilité des 
documents vers MS Word®, dans l'état actuel des outils de conversion.
En effet, dans MS Word® les en-têtes et pieds de page sont gérés au niveau de la section.
Ces deux méthodes étant assez différentes, les conversions successives d'un traitement de texte à 
l'autre entraînent rapidement des confusions dans la gestion des en-têtes et pieds de page.

4.6 Plan �  Titre �  Numérotation

OpenOffice.org propose nativement des styles de paragraphes correspondant à 10 niveaux de titres 
(Titre 1 à Titre 10) ainsi qu'un niveau de titre supérieur (Titre).

Les styles de paragraphes Titre 1 à Titre 10 sont ceux qui seront utilisés pour l'insertion d'un sommaire 
automatique. Ce sont aussi ceux qui servent à la constitution du plan du Navigateur. Et encore à la 
création automatique d'un document maître.

Plutôt que de créer des styles de titre adaptés au besoin d'une charte graphique particulière, il est 
recommandé de modifier les styles existants, ce qui évitera de changer le paramétrage de base de la 
suite.

Le Titre 1 sera attribué au niveau de plan le plus élevé, le Titre 10 au niveau le plus faible. Il est évident 
que l'on peut n'utiliser que les niveaux de plan dont on a besoin.

Pour donner la forme désirée au titre d'un paragraphe, section, chapitre, il suffit d'attribuer au 
paragraphe le style de niveau correspondant à sa situation dans le plan.
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Seuls les niveaux Titre 1 à Titre 10 sont, en standard, pris en considération pour l'établissement du 
plan dans le sommaire et le Navigateur.
Le niveau Titre n'est pas repris dans le Navigateur.
Il peut être ajouté dans le sommaire automatique. 

Numérotation

MS Word® OpenOffice.org  Texte

Format Puces et numéros
Hiérarchisation

Outils Numérotation des chapitres
Numérotation

L'utilisation de la commande Outils>Numérotation des chapitres appelle l'affichage de la boîte de 
dialogue cidessus.

L'onglet Numérotation permet de définir la numérotation

La boîte de dialogue se compose de trois parties :

• A gauche, le niveau du plan (1 le plus élevé)

• Au centre; les paramètres de définition de la numérotation

• A droite, l'aperçu de la numérotation

Une numérotation de chapitre est liée à un style de paragraphe. 

Si l'on définit une numérotation de chapitre pour un style de paragraphe, par exemple "Titre1", elle est 
toujours appliquée lors de l'application du style. Il est possible de définir 10 niveaux de plan maximum.
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Ainsi lors de l'application d'un style de paragraphe de plan avec numérotation, la numérotation est 
automatiquement mise en place et mise à jour à chaque modification du plan.

On constate que par défaut, OpenOffice.org propose que le niveau 1 soit associé au style de paragraphe 
Titre 1, 2 pour Titre 2. 

Ainsi qu'il a été indiqué au paragraphe précédent, il est préférable de conserver ces paramètres par 
défaut qui permettent de profiter des automatismes définis par défaut dans OpenOffice.org. (Sommaire 
automatique, Navigateur)

Pour définir la numérotation correspondant à un niveau il faut:

• Cliquer sur le niveau voulu en partie gauche

• Choisir le « Numéro » correspondant à la numérotation voulue

• Pour les niveaux supérieurs à 1, valoriser le paramètre « Complet ». Ce paramètre permet 
d'étendre l'affichage des niveaux supérieurs et d'obtenir l'affichage complet de la numérotation

• Valoriser les autres paramètres (caractères avant et après, numéro de commencement) si besoin 
est.

• Régler la présentation et les écarts par l'onglet Position.

L'aperçu affiche au fur et à mesure les diverses interventions sur les paramètres. Dans certains cas il 
peut être nécessaire de cliquer sur un autre niveau pour forcer le rafraîchissement de l'aperçu.

Numérotations spécifiques

L'alternance dans le choix sur le paramètre « Numéro » permet de créer des numérotations de 
style de type 1.A.I.a.i.
Le paramètre « Complet » permet de n'afficher que les niveaux supérieurs voulus.
Ainsi dans l'exemple précédent (1.A.I.a.i), si l'on veut que le titre de niveau 5 ne porte que la 
numérotation « 1.a.i » il faut valoriser le paramètre « Complet » à 3
Le paramètre « Styles de caractères » permet d'affecter à la numérotation un style différent de 
celui affecté au style de paragraphe du titre. Ces styles de caractères sont ceux définis par les 
fonctions de styles standard.
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Lors de la création de numérotation pour les niveaux supérieurs à 1, ne pas oublier de valoriser la 
paramètre « Complet » si vous voulez que votre numérotation soit affichée entièrement dans le 
titre, faute de quoi la numérotation sera tronquée..

Enregistrement des numérotations définies

Dans l'onglet Numérotation, le bouton « Format » permet d'enregistrer la numérotation ainsi 
définie et de la renommer.
Elle sera ensuite disponible dans toute la suite.

4.7 Insertion d'un sommaire automatique

Voici le tableau comparatif de commandes à utiliser pour l'insertion d'un sommaire automatique ou de 
tables d'index.

MS Word® OpenOffice.org Texte

Insertion Table et index
Table des matières
Index
Index des illustrations
Index des illustrations
Index des Illustrations

Insertion Index
Index/Table des matières
Index/Index lexical
Index/Index des tables
Index/Index des illustrations
Index/Index des Objets

Pour insérer le sommaire standard, positionner le curseur à l'endroit du texte ou l'index doit être inséré.

Puis, utiliser la commande Insertion>Index>Index. Voici la boîte de dialogue qui apparaît :
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A partir de l'onglet « Index », 

• nommer la table des matières (Par défaut, Table des matières) ;

• sélectionner Table des matières dans la liste déroulante « Type » ;

• sélectionner  Créer la table à partir de « structure » ;

• Un clic sur Ok la table des matières est créée.

Modifier la présentation de l'index

Pour modifier la présentation de l'index après sa création, il faut :
• Positionner le curseur sur l'index
• Afficher le menu contextuel
• Choisir Éditer l'index
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Mettre à jour l'index

Pour mettre à jour l'index des modifications apportées au plan ou à la pagination du document, il 
faut :
• Positionner le curseur sur l'index, 
• Utiliser la commande Outils>Actualiser>Index Actif
• Ou bien, afficher le menu contextuel, choisir Actualiser l'index
Il est également possible d'actualiser l'index sans positionner le curseur. Utiliser la commande 
Outils>Actualiser>Tout actualiser ou Tous les Index.

Ajouter des entrées supplémentaires au sommaire

Il peut être intéressant d'ajouter au sommaire standard des entrées spécifiques correspondant à 
partie du document non reprises dans le plan standard.
Ce peut être le cas pour une Introduction, un Préambule, une Conclusion ou tout autre partie.
Pour cela il faut :
• Définir un style de paragraphe pour le titre de cette partie (Le style Titre peut tout à fait 

convenir à cet usage)
• Puis dans la boîte de dialogue de définition de l'index sélectionner « Styles supplémentaires » 
• Cliquer sur le petit carré gris avec trois points ; la boîte dialogue suivante s'ouvrira 
• Chercher dans la liste le style de paragraphe à insérer à la Table des matières, le décaler vers 

la droite vers le niveau souhaité avec les flèches

Modifier les styles des paragraphes d'index

Il peut être intéressant de modifier le style des paragraphes d'index, pour mettre un espacement 
entre les titres de niveau 1 et faciliter ainsi la lecture du plan 
• Éditer l'index et choisir l'onglet Styles
• Dans le cadre « Styles de paragraphes » sélectionner le style correspondant au niveau 1
• Cliquer sur Éditer
• Modifier le style avec la boîte de dialogue qui s'affiche
Comme souvent dans OpenOffice.org, une autre méthode est possible avec le styliste en affichant 
tous les styles de paragraphe. 
Le style Table des matières Niveau 1 peut être modifié par la procédure normale. 
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4.8 Insertion de graphiques ou diagrammes

OpenOffice.org permet de créer, d'éditer et de modifier des diagrammes directement. Cet outil ne peut 
égaler en termes de complexité et de puissance les résultats obtenus par l'incorporation des diagrammes 
générés par un tableur. 

Néanmoins, dans un usage courant de rédaction de rapports, il peut être très utile pour produire des 
diagrammes directement incorporés au texte.

Deux solutions sont possibles pour créer un diagramme.

Diagramme à partir d'un tableau existant

Dans ce cas, il suffit de sélectionner la partie du tableau que l'on veut éditer sous forme de diagramme, 
puis d'utiliser l'outil Auto format de diagramme.

Exemple

Tr1 Tr2 Tr3 Tr4

Ventes 1 2 3 4

Achats 3 7 5 6

Pour accéder aux fonctions de manipulations et de modifications du diagramme, il faut sélectionner le 
diagramme par un double clic. 

Lorsque le diagramme est entouré d'une bordure grise toutes les commandes de modifications des 
données et de la présentation sont accessibles via la barre d'instruments ou les menus contextuels.

Ainsi les manipulations suivantes ont permis de modifier la couleur de la barre du trimestre 2:

• Double clic sur le diagramme pour le rendre accessible en modification (entouré de carrés 
verts) 

• Clic simple sur le graphique pour le rendre actif (entouré de carrés verts)
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• Clic simple sur la série de données à modifier (suite de carrés bleus)

• Clic simple sur la barre à modifier (entourée de carrés verts)

• Accès par le menu contextuel aux outils de manipulation (pour la couleur : propriétés de 
l'objet).

Les menus contextuels permettent à chaque étape ci dessus de modifier les propriétés des objets actifs.

De même, la barre d'instruments présente les outils adaptés à la gestion des diagrammes.

Diagramme auto constitué

Dans ce cas on utilise soit le menu Insertion>Objet>Diagramme, ou dans la barre d'instruments. Voici 
un exemple de diagramme produit par OpenOffice.org :

Pour accéder aux fonctions de manipulations et de modifications du diagramme, il faut sélectionner le 
diagramme par un double clic. 

Lorsque le diagramme est entouré d'une bordure grise toutes les commandes de modifications des 
données et de la présentation sont accessibles via la barre d'instruments ou les menus contextuels.

On peut en particulier modifier la valeur des données et les titres en intervenant directement dans un 
outil similaire à un tableur. Pour cela il faut sélectionner le choix « Données du diagramme » dans le 
menu contextuel.
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Ciaprès un aperçu de l'écran de manipulation des données: 

4.9 Les modèles

Un modèle est un document qui comporte des mises en forme (typiquement des styles) et 
éventuellement des éléments de texte ou d� autres informations (tableaux, graphiques, etc.) et qui est 
utilisé comme base pour la création des documents finals. 

Dans OpenOffice.org 2.3, les fichiers de modèles sont identifiés par des extensions spécifiques.
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Le Gestionnaire de modèles 

Le Gestionnaire de modèles est l� outil qui permet de lister et gérer les modèles dans OpenOffice.org. Il 
est accessible par l� option de menu Fichier / Modèles / Gérer. 

Création d’un modèle 

Lorsque nous créons un nouveau document dans Writer, celuici est créé selon le modèle par défaut 
fourni au lancement de l� application. Il est probable que nous voudrons rapidement ajouter des mises en 
forme qui nous sont courantes de façon à nous dispenser de recréer encore et encore les mêmes styles, 
d� un document à l� autre. 

Dans l� exemple que nous développerons ici nous montrerons comment créer un nouveau modèle qui 
offre, en plus des styles prédéfinis offerts par OpenOffice.org, un style de page « à l� italienne ». 

Nous commencerons par ajouter le style de page « à l� italienne » à la liste des styles de page déjà 
présents dans le document, puis nous enregistrerons ce document sous forme d� un nouveau modèle. En 
d� autres termes, nous ne modifierons pas le modèle par défaut.

Création du document à l� origine du nouveau modèle 

Appuyons F11 pour appeler le Styliste, sélectionnons le type de styles Page, clic-droit dans la liste et 
choix de l� option Nouveau. 
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Le dialogue de création de style de page est présenté. Nous y entrons les informations requises dans 
l� onglet Gérer.

                                  

   ->  un nom parlant, 

   ->  le style de suite (ici, le style des pages qui suivent les pages en style Paysage) a été choisi comme 
étant standard, c� est-à-dire l� orientation « à la française » ou encore « portrait »). 

N� oublions pas, au minimum, de déclarer l� orientation Paysage dans l� onglet Page de ce même 
dialogue. Nous pourrons, bien sûr, en profiter pour modifier d� autres paramètres, en fonction de nos 
desiderata. 

Après validation, le nouveau style est créé et figure dans la liste des styles de page.
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À ce niveau, le style n� existe que dans le document en cours. Pour ne pas perdre ce style et le retrouver 
dans d� autres documents, il convient maintenant d'enregistrer ce document �  par ailleurs vierge �  sous 
forme d� un nouveau modèle. 

Enregistrement du nouveau modèle 

Nous allons maintenant transformer notre document actuel en un modèle. Ainsi, lors de la création de 
nouveaux documents à partir de ce dernier, nous retrouverons le style de page Paysage prêt à l� emploi. 
À nous d� imaginer une foule d� autres styles à intégrer à une foule d� autres modèles que nous utiliserons 
ensuite selon nos besoins (modèle de courrier interne, modèle de lettre, modèle de rapport, etc.) 

Le nouveau modèle peut être enregistré soit dans le dossier standard des modèles 
(<installation>\user\template ou  \Documents and Settings\<User>\Application 
Data\OpenOffice.org2\user\template sous Windows) , soit ailleurs. 

Pour enregistrer notre document comme modèle dans le dossier \user\template, il suffit d� appeler 
l� option Fichier / Modèles / Enregistrer.

4.10 Pratique

Composer les étiquettes

La boîte de dialogue Étiquettes vous permet à la fois de concevoir des étiquettes et des cartes.

1. Via la commande Fichier - Nouveau - Étiquettes, ouvrez la boîte de dialogue Étiquettes.

2. Sur l'onglet Étiquettes, définissez dans la section Format le format des étiquettes.

OpenOffice.org Writer contient de nombreux formats de feuilles disponibles dans le commerce 
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pour l'impression d'étiquettes, de badges et de cartes de visite. Vous pouvez également ajouter 
d'autres formats utilisateur.

3. Sur l'onglet Étiquettes, sélectionnez dans la section Libellé le libellé des étiquettes.

Pour ce faire, vous aurez fréquemment recours aux champs de base de données de façon à 
personnaliser le contenu des étiquettes à imprimer, notamment pour l'envoi de "lettres type". Il 
est également possible d'imprimer le même texte sur chaque étiquette.

Utilisez les zones de liste Base de données et Table pour sélectionner la base de données et la 

table desquelles sont issus les champs de données. Cliquez sur le bouton fléché pour transférer 
le champ de données sélectionné dans la zone d'inscription. Appuyez sur Entrée pour insérer un 
retour à la ligne. Vous pouvez également saisir des espaces et tout autre texte fixe.

L'onglet Format vous permet de définir des formats d'étiquette que les formats prédéfinis ne 

proposent pas. Pour ce faire, sélectionnez Utilisateur dans la zone de liste Type. L'onglet 

Options permet d'indiquer si vous souhaitez créer toutes les étiquettes ou seulement certaines 

d'entre elles.

4. Dans l'onglet Options, veillez à cocher la case Synchroniser le contenu. Si tel est le cas, il 

suffit de saisir une étiquette (dans le coin supérieur gauche) et de l'éditer une seule fois.

5. Dès que vous avez cliqué sur 

Nouveau document, une petite 

fenêtre apparaît comportant le 

bouton Synchroniser les 

étiquettes. Saisissez la première 

étiquette. Dès que vous cliquez 
sur ce bouton, l'étiquette active 
est copiée dans toutes les autres 
étiquettes de la feuille.

6. Cliquez sur Nouveau document pour créer un nouveau document avec vos paramètres 

prédéfinis.

Pratique - Mailing

1) Créer la lettre-type
2) Se connecter à la base de données �  tableur : Fichier �  Assistant �  Source de données des 

adresses �  Autre source de données externes �  Paramètres �  Classeur �  recherche emplacement 
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et sélection du fichier - Terminé
3) Cliquer sur F4 pour afficher la base de données sélectionnées
4) Ajouter les champs correspondants sur la lettre-type

Pratique �  Macro

Créer une macro pour une mise en évidence

1) Ecrire un mot

2) Sélectionner ce mot (deux clics rapides)

3) Commande : Outils �  Macro �  Enregister (fenêtre macro)

4) Début enregistrement �  format �  caractères �  effets �  attributs (majuscule, couleur, relief)

5) Fin de l'enregistrement

6) Nommer la macro « evidence »

Exécuter la macro

Outils �  Macro �  choix �  exécuter
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5. LE TABLEUR �  COMPARATIF : EXCEL® - CALC

Cette partie détaille les fonctionnalités spécifiques aux tableurs de chaque suite. La comparaison porte 
sur les modalités d'utilisation des tableurs et les commandes correspondantes de menu ou de raccourci 
clavier. 

Le principe de fonctionnement du tableur étant largement établi, l'aspect général des deux suites est 
quasiment identique. 

Une feuille de calcul présente un tableau de cellules numérotées en ligne (lettres) et en colonne 
(chiffres). Les feuilles de calcul du classeur sont adressables par des onglets en bas d'écran

L'introduction de valeurs dans une cellule se fait de la même façon dans les deux suites par saisie 
directe ou dans la zone de saisie. 

De même, les calculs sont réalisés selon les mêmes principes. Dans une cellule, peuvent s'effectuer des 
calculs sur des valeurs brutes ou le contenu de cellules adressées en position absolue ou relative.

Des outils permettent la totalisation rapide en ligne et colonne permettent d'établir très aisément des 
tableaux à double entrée.

Les deux suites disposent d'un outil de création de graphiques ou diagrammes simple d'utilisation.

Toutefois, le tableur de la suite OpenOffice.org qui était limité à 32000 lignes vient de rejoindre Excel® 
à 65000 lignes.

5.1 Commandes comparées pour la réalisation de feuilles de calcul

Les tableaux ciaprès font la comparaison des commandes contenues dans les menus des deux Tableurs. 
Ils ne sont que le fruit d'une expérience d'utilisateur et ne sont pas exhaustif des capacités complètes des 
tableurs comparés.

Les fonctions commentées sont notées par un dièse (#) et font l'objet d'une explication complémentaire 

après chaque  fin de tableau.

Les raccourcis sont donnés à part et les combinaisons de touches sont notées en gras souligné. 

Par exemple : Un nouveau Fichier peut s'appeler par le raccourcis Ctrl+N ou par Alt+F puis N.

A noter que certains raccourcis ne sont pas mentionnés dans les menus comme Fermer (Ctrl+W). Ils 
sont mentionnés quand même tant que faire se peut.
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La liste complète est disponible dans l'aide de OpenOffice.org. ou sur le site francophone.

Dans la comparaison, la priorité est donnée à l'utilisateur Excel® en lui donnant l 'équivalent 
OpenOffice.org.

5.2 Menu Fichier

MS Excel®  (installation standard) OpenOffice.org Calc

Menu Clavier Menu Clavier

Fichier 

...# Nouveau

... Ouvrir

... Fermer...

... Enregistrer 

... Enregistrer sous

... Enregistrer (...) page Web

 

...# Enregistrer un environnement

...# Aperçu de la page Web

...# Mise en page

...# Zone d'impression.

... Aperçu avant impression

... Imprimer

... Envoyer vers 

... Propriétés

... (Derniers fichiers ouverts)

... Quitter

(pas de commande équivalente)
(Voir Fichier Nouveau)

Ctrl N
Ctrl O
Ctrl W
Ctrl S

Ctrl P

Fichier

... Nouveau (ou Autoplilote )

... Ouvrir

... Fermer...

... Enregistrer

... Enregistrer sous

... Enregistrer sous

Type Page Web
(pas de commande équivalente)

(pas de commande équivalente)

Format Page

... Zones  d'impression

Fichier Aperçu

... Imprimer...

...  Envoyer 

...  Propriétés 

... (Derniers fichiers ouverts)

...  Quitter

Particularités du menu OpenOffice.org

... Tout enregistrer

... Autoplilote

Ctrl N
Ctrl O
Ctrl W
Ctrl S

Ctrl P

Ctrl Q
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5.3 Mise en page 

Pour préparer facilement vos mises en page avec OpenOffice.org vous pouvez mettre les marges à zéro ; 

le message d� avertissement permet (si vous répondez Non) de récupérer les marges � vraies�  de 

l� imprimante. Vous êtes ainsi assuré d� imprimer sans perte tout en utilisant les capacités de votre 
imprimante.

Exemple : 
Ici une Canon S450.

(Excel® autorise les marges à 
zéro sans rien dire et ne vous 
donne pas les marges de l� im-
primante. A l� impression vous 
n'aurez un message que si la 
page à l� écran dépasse les capa-
cités de l� imprimante.)

Avec Excel® il est délicat de savoir si les sauts de pages sont le reflet des capacités de l'imprimante.

En effet, Excel® accepte les marges à zéro sans message d'alerte et il ne récupère pas les marges de 
l'imprimante. Toute adaptation des sauts de pages à la souris, dans le document, passe par un zoom qui 
n'est pas forcément voulu par l'usager.

OpenOffice.org vous donne les marges de l'imprimante (version Windows) ce qui permet de les 
paramétrer très précisément. Dans notre cas (Canon S450) on peut mettre toutes les marges à 0,50cm 
pour les harmoniser. Les sauts de pages respecteront ce réglage. Sur un Tableur on passe toujours 
beaucoup de temps à régler le document pour une bonne mise en page.

5.4 Zone d� impression

Pour Excel® la zone d� impression est une zone que vous sélectionnez, puis elle reçoit  un nom 
(zone_d_impression) ; elle est gérée comme une simple cellule (ou groupe de cellules) nommée. 

D� ailleurs vous pouvez la modifier avec la fonction Insertion �  Nom �  Définir  mais elle est unique 

par feuille.
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Pour OpenOffice.org les Zones d� impression sont définies dans le menu Format �  zone d� impression. 

Cela permet de créer et gérer les zones d� impression du document. En effet elles peuvent être multiples.

Voir aussi le menu Affichage �  Aperçu des sauts de pages.

5.5 Menu Édition

MS Excel®  (installation standard) OpenOffice.org Calc

Menu Clavier Menu Clavier

Édition

... Annuler

... Répéter

... Couper

... Copier

... Coller

... Collage spécial

...# Collage (...) hypertexte

... Recopier

... Effacer

...# Supprimer

...# Supprimer une feuille

... Déplacer copier une feuille

... Rechercher

... Remplacer

...# Atteindre

...# Liaisons

...# Objet (suivant l'objet)

Outils Suivi des modifications

Outils Fusionner les classeurs

Affichage En-têtes et pieds de page

( Absent ! mais Raccourcis valide )

Ctrl Z
Ctrl Y

Ctrl X
Ctrl C
Ctrl V

Ctrl F
Ctrl H
Ctrl T

Ctrl A

Édition

Annuler

... Répéter

... Couper

... Copier

... Coller

... Collage spécial

Insertion Hyperlien

Édition Remplir

... Supprimer du contenu

... Supprimer des cellules

... Supprimer la feuille

... Déplacer/copier la feuille

... Rechercher et remplacer

...       '' - ''

... Navigateur

... Liens

... Objet (suivant l'objet)

Particularités du menu OpenOffice.org

... Modifications

... Comparer le document

... En-têtes et pieds de page

... Sélectionner tout

Ctrl Z
Ctrl Y

Ctrl X
Ctrl C
Ctrl V

Suppr.

Ctrl F

F5

Ctrl A
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MS Excel®  (installation standard) OpenOffice.org Calc

Insertion Supprimer / Saut de page ... Supprimer le saut manuel

5.6 Effacer

Pour Excel® la fonction Effacer offre des choix. 

Avec OpenOffice.org vous l� avez disponible directement par la touche Suppr de votre clavier. Veuillez 

noter que la touche Retour arrière (Backspace) permet un effacement sans choix. Des combinaisons 

avec les touches Ctrl et Maj sont possibles mais bien souvent les systèmes et logiciels installés (souris), 

contrarient ces options. A vous de les explorer.

NOTA : La touche F2 quant à elle, permet d� éditer le contenu des cellules sans en effacer le contenu.

5.7 Supprimer une feuille

Comme dans tous ces tableurs l� usage du bouton droit 
de la souris sur un objet permet d� accéder à un menu 
contextuel qui donne les principales fonctions dispo-
nibles.

Cela remplace avantageusement le menu.

NOTA: Pour renommer une feuille ...

Sur Excel® un double clic gauche sur le nom.

Sur OpenOffice.org  Alt+clic gauche.
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5.8 Atteindre

Cette fonction d� Excel® permet d� at-
teindre des cellules et repose princi-
palement sur les cellules nommées.

Mais en seconde option le  bouton 

Cellules permet plus encore. Là nous 

avons affaire à une recherche discri-
minatoire selon des critères 
multiples.

Dans OpenOffice.org, on est tenté 

d� opposer les capacités du Naviga-

teur (F5) car il permet d� atteindre 

tous les objets constituant notre document.

A priori il ne permet pas de sélectionner les cellules selon tous les critères que propose Excel®.

Voici quelques méthodes de substitution:

Excel® OpenOffice.org 

Commentaires 

Constantes
Formules

Objets 

Dernière cellule

Navigateur - Notes

Affichage - Valeurs
formules    = vert
Constantes = bleu

Navigateur �  Objet Ole
Navigateur �  Images
Navigateur �  Dessin

Dernière cellule (Zone)

Dernière cellule (ligne)
Première cellule (ligne)

F5

Ctrl F8

F5

Ctrl Fin

fin
début
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6. LES PROGRAMMES DE DESSIN ET DE PRÉSENTATION �  COMPARATIF 

POWERPOINT® ET IMPRESS/DRAW

Cette partie détaille les fonctionnalités spécifiques aux outils de présentation de chaque suite. La 
comparaison porte sur les modalités d'utilisation de ces outils et les commandes correspondantes de 
menu ou de raccourci clavier. 

Le principe de fonctionnement d'un outil de présentation est de permettre la création de diapositives et 
d'en assurer l'affichage soit en mode automatique soit en mode manuel. Les résultats à obtenir étant très 
standards, l'aspect général des deux suites est quasiment identique. 

Les deux suites disposent donc d'outils de présentation comparables. 

6.1 Notions d'utilisation de Impress

Pour Impress, quelle que soit l'insertion que vous faites, que ce soit une image, du texte, un dessin, du 
son, il s'agit en fait d'un objet. Chacun de ces objets peut ensuite recevoir une animation : mouvement, 
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temporisation, coloration, sonorisation.

Vous avez accès à la barre d'outils contextuelle correspondante à l'objet appliqué : barre d'outils de 
traitement de texte pour un cadre de texte, barre d'outils de dessin pour un rectangle, etc.

Lorsque vous appliquez un effet à un objet, celuici est directement visible ou audible par simple clic 
dans une fenêtre de visualisation liée à la boite d'effet. De même, c'est dans cette boite d'effet que vous 
réglez l'ordre d'apparition des objets sur la diapositive, un simple glissé/déplacé d'un objet sous un autre 
vous le permet.

Voici une idée de votre espace de travail en mode dessin.

Enfin différents modes sont accessibles pour vous permettre de créer rapidement des diapositives et 
d'organiser votre diaporama. D'autres modes sont disponibles, mais ils se rapprochent de ceux que vous 
connaissez déjà (comme le mode plan par exemple).

Arrière-plan

L'icône d'arrière plan vous amène au fond de la diapositive. Vous pouvez insérer ici les différents objets 
que vous souhaitez voir apparaître sur les diapositives tout au long de la présentation. Ainsi vous y 
placerez le logo de votre société ou encore la date ou bien le numéro de page.

Bien sûr, en utilisant un style de page pour l'arrière plan vous pourrez modifier celuici de façon 
ponctuelle pour une seule diapositive (style de page particulier attaché à cette diapositive) ou de façon 
durable pour toutes vos diapos (modification du style de page standard).

Mode couche

Une couche fonctionne comme un transparent. Ainsi, dans ce mode, c'est comme si vous superposiez 
différents transparents sur une diapositive. Sur chaque couche vous pouvez insérer différents objets 
avec leurs animations. L'avantage, c'est que vous pouvez décider de faire apparaître ou non une couche 
placée sur une diapositive, de même vous pouvez décider de son impression ou non, ou bien encore en 
bloquer l'édition pour qu'elle ne soit jamais modifiée.

Mode diapositive

Ce mode est réservé à l'organisation de la présentation. C'est ici que vous pourrez modifier l'ordre de 
vos diapositives, en insérer venant d'une autre présentation ou encore en copier, ceci par simple 
glisser/déposer.
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Ce mode vous permet également d'insérer une transition entre les diapositives, des effets de fondus 
enchaînés ou d'apparition vers la droite ou la gauche, etc... C'est enfin  ici que vous réglerez la 
temporisation d'affichage des diapositives et de transition.

Mode live

Ce mode vous permet d'ajouter la dernière touche à votre présentation. En effet, vous pouvez intervenir 
directement à l'intérieur du diaporama alors qu'il est en train de défiler à l'écran via le navigateur, cela 
permet entre autres de faire des réglages fins, de mieux régler une temporisation...

Mode notes

Enfin, ce mode est réservé à la prise de note sur votre diaporama. Cela peut vous servir de base pour le 
commentaire oral que vous allez faire, ou encore permettre à votre auditoire d'en garder une trace écrite 
relative à chaque diapositive si vous avez décidé de l'imprimer. Il est ainsi possible d'optimiser le type 
d'impression que vous désirez : uniquement des notes, réservé à une présentation papier, seulement 
certaines diapositives et leurs notes...

6.2 Réalisation d'une présentation simple

Les deux suites proposent des modèles de diapositives et des types d'enchaînements prédéfinis. Il est 
donc aisé de réaliser une présentation simple comportant une suite de diapositives qui se succèdent 
selon des enchaînements standards.

Le tableau ciaprès récapitule les commandes de chacune des suites nécessaires pour réaliser une 
présentation simple.

MS Powerpoint® OpenOffice.org  Impress

Commande menu Clavier Menu Clavier

Édition Sélectionner tout
Effacer
Dupliquer
Supprimer la diapositive

Ctrl A
Suppr
Ctrl D

Édition Sélectionner tout

Dupliquer
Supprimer la page 

Ctrl A
Suppr
Maj F3

Affichage Diapositive
Plan
Trieuse de diapositives

Affichage Mode de travail
Mode Dessin
Mode Plan
Mode Diapo

Formation OpenOffice.org -- Moving Art Studio a.s.b.l.-- page 71



MS Powerpoint® OpenOffice.org  Impress

Page commentaires
Pas de commande équivalente
Affichage Diaporama

Diapositive miniature

Mode Notes
Mode Prospectus

Pas de commande équivalente
Affichage Aperçu

Insertion Nouvelle diapositive
Dupliquer la diapositive

Insertion
Numéro de diapositive
Date et heure
Tabulation
Caractères spéciaux

Insertion Page
Dupliquer la page

Insertion Champs
Numéro de page
Date/Heure

Caractères spéciaux
Tab

Format Police
Puce
Alignement
Interligne
Changer la casse
Mise en page des diapo ...

Format Caractères
Numérotation/Puce
Paragraphe>Alignement
Paragraphe>Interligne
Casse/Caractères
Modifier la mise en page

Diaporama
Visionner le diaporama

Présentation à l'écran
Présentation à l'écran

6.3 Réalisation d'une présentation personnalisée

Le présent paragraphe reprend les principales fonctionnalités permettant d'obtenir des présentations 
sophistiquées soit avec des outils plus élaborés, soit à l'aide de modèles, soit au moyen d'images et de 
sons incorporés.

A cet égard, il convient de remarquer que la suite MS Office® est largement mieux fournie en supports 
tels que fonds de pages, modèles, images,...

La création de présentation comportant du son par enregistrement n'est pas disponible dans 
OpenOffice.org.

Il est cependant possible d'introduire des fichiers sons pour chaque diapositive, mais pas possible par 
exemple de lancer un commentaire couvrant toute la présentation.

MS Powerpoint® OpenOffice.org  Impress

Fichier Enregistrer au format HTML Fichier Enregistrer
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MS Powerpoint® OpenOffice.org  Impress

Présentation à emporter
Page Web

Pas de commande équivalente

Pas de commande équivalente
Édition Liaisons

Objet
Pas de commande équivalente

Édition Navigateur
Édition Liens

Objet
ImageMap

Affichage Masque
Noir et Blanc

Pas de commande équivalente
Commentaires du Présentateur
Commentaires
En-tête Pied de page

Pas de commande équivalente

Affichage Couche
Qualité de l'affichage
Qualité de l'aperçu

Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente
Affichage  Arrière plan

Insertion Diapositive de fichier
Diapositive de Plan

Insertion Commentaire
Insertion Image

Zone de texte
Films et sons
Diagramme
Liens Hypertexte

Pas de commande équivalente
Pas de commande équivalente

Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente
Insertion Image
Barre d'instruments
Pas de commande équivalente
Insertion Diagramme

Hyperliens
Table
Frame

Format Remplacer les Polices
Jeu de couleurs des diapositives
Arrière Plan
Appliquer le modèle

Format Couleurs et traits

Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente

Pas de commande équivalente
Format Remplissage

Page>Arrière plan
Pas de commande équivalente
Format Ligne et
Format Position et taille
Format Cotation
Format Connecteur
Format Style

Styliste
FontWork
Effet 3D
Groupe
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MS Powerpoint® OpenOffice.org  Impress

Outil Image Automatique
Diapo-Conférence
Aide-mémoire

Pas de commande équivalente
Pas de commande équivalente
Pas de commande équivalente

Diaporama
Vérification du minutage
Enregistrer la narration
Paramètres du diaporama
Afficher sur deux écrans
Boutons d'actions
Prédéfini l'animation

Personnaliser l'animation

Aperçu de l'animation
Transition

Présentation à l'écran
Présentation chronométrée

Pas de commande équivalente
Paramètres de la présentation

Pas de commande équivalente
Pas de commande équivalente

Animation 
Effets
Animation
Effets

Pas de commande équivalente
Transition
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7. LA COMPATIBILITÉ DES FICHIERS 

La migration d'une suite bureautique vers une autre suite impose de fait une période de cohabitation des 
deux suites chez les utilisateurs. Pendant cette période de cohabitation et ultérieurement vers des 
services externes équipés d'une suite différente va se poser inévitablement le problème de la 
compatibilité des fichiers.

Il ne faut pas se leurrer, la compatibilité totale entre les fichiers produits par chacune des suites n'existe 
pas d'autant plus que les formats de fichiers de certaines suites sont propriétaires et non divulgués et 
que ces formats varient selon les versions.

Une compatibilité partielle peut être obtenue de manière à minimiser les problèmes rencontrés dans les 
échanges de fichiers produits par les deux suites.

En tout état de cause, les difficultés de passage d'une suite à l'autre seront d'autant plus grandes que l'on 
utilisera les fonctions avancées de chacune des suites.

Enfin, il convient de remarquer que certains documents types ou modèles peuvent avoir été créés dans 
des versions anciennes de la suite MS Office®. Avec l'évolution des formats successifs de la suite MS 
Office® ces documents ont subi des conversions qui héritent des formats antérieurs. Certaines des 
spécificités anciennes sont présentent dans le fichier utilisé sans que l'utilisateur en soit averti. La 
conversion de tels documents peut réserver de belles surprises

Les paragraphes ciaprès essaient de récapituler les conseils pour obtenir une meilleure compatibilité.

7.1 Les formats d'écriture dans OpenOffice.org

La suite OpenOffice.org peut produire des fichiers dans les formats d'autres suites et en particulier dans 
les formats Microsoft Office®.

Il ne faut cependant pas perdre de vue que ces formats externes ne sont pas les formats natifs de 
OpenOffice.org. Utiliser les formats externes revient donc à exécuter une conversion de format à 
chaque fois que l'on enregistre le document.

Il n'est donc pas recommandé d'utiliser les formats externes comme formats de travail.

La règle à suivre est que tout document créé avec OpenOffice.org doit l'être dans le format natif de la 
suite : traitement de texte, tableur, présentation.

L'utilisateur doit enregistrer dans ces formats natifs tout au long de son travail. 
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Si le fichier produit doit être transmis à un service externe n'utilisant pas OpenOffice.org, ce n'est qu'en 
dernier lieu, juste avant transmission, que l'on enregistrera le document au format externe.

7.2 Les méthodes de travail inter groupes

Il est de plus en plus fréquent que des documents (le plus souvent notes ou rapports, rarement des 
classeurs) soient produits par plusieurs services ; le  service compétent se chargeant d'élaborer la note 
sur le fond et demandant des avis ou compléments aux autres services.

Dans ces cas, il est évident que les documents vont faire des allers et retours entre les différentes suites.

La recommandation principale est donc que les services doivent s'accorder pour établir tout d'abord le 
fond du document et son organisation générale sans se préoccuper la forme. Cette recommandation est 
également valable si le service initiateur de la note n'utilise pas OpenOffice.org 

En effet, c'est principalement dans la mise en forme du document que se pose les problèmes de 
compatibilité.

La mise en page générale (marges, en-tête et pied de page, numérotation des pages, positionnement des 
logos, sommaire éventuel) doit  être de préférence effectuée lorsque tous les services se seront accordés 
sur le contenu de la note. Cette tâche incombera au service initiateur du document.

Il convient de remarquer que les outils de plan sont d'une très bonne compatibilité entre suites et que 
dans ces conditions si l'on évacue le problème de la mise en forme et de la présentation finale le travail 
inter service peut parfaitement s'organiser avec des suites différentes.

Une autre solution est d'implanter la suite OpenOffice.org comme suite complémentaire dans les 
services externes. Cette implantation ne peut poser de difficultés financières puisque la suite est 
gratuite.

De plus, son utilisation respecte les mêmes principes de fonctionnement que la suite Microsoft. Un 
utilisateur ne devrait donc pas ressentir de gêne importante à l'utilisation de OpenOffice.org pour 
valider, corriger ou apporter des compléments à un document principalement élaboré par un autre 
service;

7.3 Les principales difficultés de conversion

A l'ouverture dans OpenOffice.org d'un fichier créé dans la suite MS Office®, on constate, à l'affichage 
sur l'écran ou à l'impression, que la mise en page des documents est généralement bien conservée.

Les difficultés commencent quand il faut enregistrer ce document d'origine MS Office®, soit dans un 
format natif de OpenOffice.org, soit  dans un format propriétaire de MS Office®. C'est en effet à ce 
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moment là que l'on constate des pertes de format.

Il faut bien insister sur le fait que les seuls problèmes rencontrés portent sur la mise en forme des 
documents, en aucun cas sur leur contenu.

A cet égard, il faut distinguer les conséquences liées à l'enregistrement du fichier de celles liées à sa 
fermeture.

A chaque opération d'enregistrement ou de fermeture dans un format qui n'est pas celui du fichier 
d'origine ou qui n'est pas celui natif de OpenOffice.org, le logiciel annonce que des pertes de format 
sont possibles.

En réalité, les pertes de format ont lieu lors de la fermeture du fichier. OpenOffice.org convertit 
effectivement le fichier dans sa nouvelle structure lors de l'opération de fermeture.

L'utilisateur non averti pourra ainsi croire que les modifications qu'il effectue seront définitives car il 
les a enregistrées et continuera son travail en toute bonne conscience. En réalité, certaines de ces 
modifications de mise en page seront perdues lors de la fermeture du fichier. Le résultat obtenu dans la 
conversion pourra donc être différent de celui attendu.

Ces problèmes sont toutefois bien cernés et recensés ci dessous.

Les macros

C'est la principale difficulté de conversion entre les deux suites. Les langages utilisés ne sont pas 
compatibles et les macros utilisées dans un fichier MS Office® ne sont pas utilisables sans réécriture 
importante dans OpenOffice.org.

Cette difficulté est particulièrement sensible pour les fichiers Excel® dans lesquels il est fréquent 
d'inclure des macros.

Un projet vient d'être initié pour créer un convertisseur de macros. Cependant, ce convertisseur ne sera 
pas opérationnel dans l'immédiat.

Les styles de caractères, paragraphes et pages

La principale difficulté de la conversion vient du fait que dans la majeure partie des cas les fichiers 
créés avec la suite MS Office® n'utilisent pas les fonctions de style.

La suite OpenOffice.org privilégie l'utilisation des styles.

De ce fait, lors de la conversion de fichier toutes les surcharges de mise en forme effectuées avec des 
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commandes Format Caractères ou Paragraphes, etc sont transformées en styles de conversion. On voit 
donc apparaître dans la liste des styles nommés « WWxxxx » qui sont autant de styles de paragraphes, 
de caractères, de numérotation, attachés à une mise en forme particulière.

Le problème est particulièrement sensible pour la mise en page des documents ou OpenOffice.org 
utilise un style de page alors que MS Office® attache la mise en page à la section.

La solution réside donc dans une utilisation dans les deux suites des styles. Les résultats de conversion 
les meilleurs sont obtenus dans cette situation.

Les marges

La conversion d'un fichier MS Office® dans un format OpenOffice.org ne conserve pas les marges 
d'origine. en particulier, celle du haut de page.

Ainsi qu'il a été écrit au paragraphe précédent, la conversion crée des styles de page, chaque fois que la 
mise en page change (en tête, pied de page, marges, etc.). Il en résulte que les pages du document 
converti sont affectées d'un style de page « Conversion » et que ces styles peuvent être très nombreux.

Pour éliminer, ces problèmes de marges, il faut donc 

• soit agir sur chacun des styles de conversion pour restaurer les marges ;

• soit supprimer ces styles et appliquer les styles de page natifs ou créés sur le document 
converti. 

Les en-têtes et pieds de page

Dans OpenOffice.org les en-têtes et pieds de page sont attachés au style de page. Cette méthode permet 
sans conteste de gérer les mises en page de manière beaucoup plus fine et naturelle.

Elle a cependant des effets redoutables dans les cas où il est nécessaire de modifier un fichier entre 
plusieurs services dotés chacun d'une suite différente. Dans ce cas, il est nécessaire de procéder à des 
conversions multiples et on constate que 2 ou 3 conversions d'un format dans l'autre suffisent à détruire 
la présentation des en-têtes et des pieds de page.

Si l'on se trouve dans cette situation, la seule solution est de réserver la création des en-têtes et des 
pieds de page au service qui finalise le document et d'éviter de mettre des en-têtes ou pieds de page dès 
le début de la création du document.
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Les écarts avant et après dans les tableaux 

OpenOffice.org considère que les écarts avant et après un paragraphe ne sont pas pris en compte pour 
régler la distance entre le texte et la bordure dans les cellules d'un tableau. Il faut pour cela utiliser un 
paramètre spécial «  Écart avec le contenu ».

Cette solution permet d'obtenir une présentation tout à fait paramétrable des tableaux.

En revanche, dans la conversion d'un fichier de MS Word® vers OpenOffice.org Writer ou l'inverse, les 
paramètres utilisés par chacune des suites ne sont pas repris par l'autre.

Il n'y a pas d'autre solution que de reprendre la mise en forme dans l'une ou l'autre suite sur le document 
final.

Le titre du document

Lors de la conversion dans OpenOffice.org, le titre du document est initialisé par les premiers mots 
contenus dans le document source.

De ce fait, à l'affichage du document, OpenOffice.org, indique dans la barre de titre, un titre sans 
signification particulière au lieu du nom du fichier ou de son titre réel.

Pour corriger ce défaut, après conversion, il faut modifier les propriétés du document par la commande 
Fichier>Propriétés onglet Description et :

• soit supprimer le titre pour obtenir l'affichage du nom du fichier ;

• soit modifier le titre qui remplacera le nom de fichier dans la barre de titre ;

Après cette opération, fermer le fichier. A la réouverture, la modification sera opérationnelle.

Les fonctions avancées de mise en  forme

Il est évident que plus les documents à convertir utiliseront des fonctions avancées de mise en forme 
plus l'utilisateur rencontrera de difficultés lors de la conversion.

On peut citer à titre d'exemple les fonctions suivantes :

• les insertions de légendes sous forme de bulles de texte

• certaines modifications de mise en forme natives dans les graphiques (légendes en particulier)

• assez généralement certaines mises en forme provenant des outils de dessin ;
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La liste précédente n'est pas limitative. Il appartient à chacun de se forger sa propre expérience et 
d'éviter de recourir autant que faire se peut à ces outils dans le cas d'un travail collaboratif avec des 
services ne disposant pas de suites identiques.

Dans ces cas d'utilisation de fonctions de mise en forme avancées somme toute assez peu nombreux, la 
solution la plus simple est d'équiper les services qui collaborent de la même suite.

Dans cette perspective, le principe d'économie conduira à diffuser la suite gratuite OpenOffice.org.

7.4 La reprise de documents dans OpenOffice.org

Dans ce paragraphe, il s'agit de donner quelques consignes qui peuvent être appliquées lorsqu'il s'agit 
d'utiliser OpenOffice.org pour lire ou modifier ou utiliser des fichiers créés dans la suite MS Office®

Document en communication

Dans ce cas, il s'agit simplement de lire un document transmis dans un format de la suite MS Office®, 
la simple ouverture du document suffit pour en prendre connaissance.

Dans ce cas la mise en forme du document source est généralement très bien respectée. De même 
l'impression ne pose pas de problème majeur.

On peut donc laisser le document dans son format propriétaire d'origine sans faire réellement de 
conversion. 

A la fermeture dans OpenOffice.org, il suffit simplement de ne pas enregistrer les modifications si une 
telle demande est formulée par le logiciel.

Document à modifier

Il s'agit dans ce cas de travail collaboratif entre plusieurs services dotés de suites différentes. 

La difficulté  est d'évaluer a priori le nombre de conversions qui vont être effectuées dans les échanges 
entre services.

Si ces conversions risquent d'être peu nombreuses (un aller et retour entre service) on peut conserver le 
format MS Office® qui est compris par les deux suites. Les perturbations générées par les 
modifications apportées dans chacune des suites seront peu génératrices de problèmes. Ces 
perturbations seront d'autant moins nombreuses que la mise en forme sera simplifiée.

Sinon, il faut se replier sur les méthodes de travail inter-groupe, donc d'éviter d'utiliser dans les étapes 
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de création du document les fonctions de mise en page qui posent problèmes et de réserver la mise en 
forme définitive à l'étape finale.

Document à utiliser comme modèle ou à réutiliser souvent

Dans ce cas il s'agit de reprendre des modèles ou documents types provenant de MS Office® dans un 
format natif de OpenOffice.org. Il s'agit de créer des documents à usage régulier et partagés dans un 
même service et qui seront exclusivement utilisés dans la suite OpenOffice.org.

Aucun résultat satisfaisant à moyen et à long terme ne sera obtenu par une conversion du fichier source. 
En effet, malgré toutes les opérations de nettoyage des formats de conversion qui seront menées, il 
restera toujours des séquelles de l'origine externe à la suite OpenOffice.org du document. Un jour ou 
l'autre des problèmes de mise en forme inopérante ou mal opérante apparaîtront sans explication ou 
correction possibles.

De ce fait, il est recommandé pour des documents types ou modèles de les récréer nativement dans le 
format OpenOffice.org.

A cet égard, pour créer un nouveau document type ou modèle, il ne faut pas utiliser les fonctions de 
Copier/Coller ou Glisser/Déposer entre les deux suites. 

En effet par ces fonctions, on importe dans OpenOffice.org les attributs de caractères ou de mise en 
forme liés à la partie sélectionnée et issus de MS Office®. Le résultat serait donc comparable à une 
conversion et les fichiers obtenus ne seraient pas nativement au format OpenOffice.org.

7.5 Création de document pour MS Office® dans OpenOffice.org

On se place dans l'hypothèse d'un service équipé de OpenOffice.org et devant produire un document à 
destination d'un autre service doté de MS Office®.

Il est absolument déconseillé de créer entièrement un document dans OpenOffice.org au format MS 
Office®. Les multiples enregistrements, ouverture et fermeture du document avant sa finalisation 
conduiraient à des résultats proches de conversions successives.

Le document doit donc être créé au format natif de OpenOffice.org. Toutes les modifications effectuées 
tant que le document n'est pas finalisé doivent être enregistrées dans ce format natif.

Ce n'est qu'au moment de la transmission vers le service externe utilisateur de MS Office® que 
l'enregistrement dans un format propriétaire doit être effectué.

De cette manière le fichier ouvert par le service externe comportera le minimum de problème  lors de 
l'ouverture et l'utilisation.

Formation OpenOffice.org -- Moving Art Studio a.s.b.l.-- page 81



APPENDIX

A. Installation d'OpenOffice.Org sous differents systèmes d'exploitation

A.1 Installation sous Linux Ubuntu

Installation graphique :

Vous pouvez installer OpenOffice.org via le Gestionnaire des paquets Synaptic: 
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Le Gestionnaire se lance : 

Cliquer sur l'icône Rechercher : 

pour rechercher le paquet d'installation OpenOffice.org

Cliquer droit sur le paquet openoffice.org et puis, sur sélectionner pour installation. Le Gestionnaire 
vous proposera alors d'installer aussi des dépendances éventuelles.
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Installation en ligne de commande

Lancer le terminal et raper la commande suivante :

$ sudo apt-get install openoffice.org
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A.2 Installation sous Mac OS X®

Pour installer OpenOffice.org2 sur votre Mac, il vous faudra disposer de 

– Mac OS X® 10.3 (aka Panther) sinon de la version 10.4 ( Tiger)
– de la version de X11 correspondant à votre version de Mac OS X®.
– de l'archive qui contient OpenOffice.org2 

Les progrès sur la version Mac étant rapides, nous tenons une version actualisée du guide 
d'installation à disposition sur le site :
http://fr.openoffice.org/docs/MacOSX_Install_fr_HowTo_OOo2.pdf 

Installation simplifiée de X11

Sans X11,  la version actuelle d'OpenOffice.org2.3 ne peut pas fonctionner.
Note : pour des réglages complémentaires, merci de consulter la partie 3) Réglages complémentaires de 
X11.
X11 est normalement disponible sur le DVD d'installation de Tiger, ou à l'adresse suivante pour la 
version correspondant à Panther : 
Pour installer X11, il suffit de double-cliquer sur l'archive téléchargée, et de répondre aux 
questions.Vous devrez disposer des droits d'administrateur (admin) pour avoir le droit d'installer X11 
sur votre machine.

Installation d'openOffice.org2.3 pour Mac OS X ®/ X11

Note : il faut avoir les droits d'administrateur pour avoir le droit d'installer OpenOffice.org2.3 sur la 
machine.
Copiez l'archive téléchargée sur le bureau
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Positionnez le curseur de la souris sur l'archive , et double cliquez dessus. Suivez les instructions 
d'installations
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Copiez par Drag'n drop l'icône OpenOffice.org dans le dossier Applications.

Ouvrez le dossier Applications
Dockez  l'icône.
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Pour lancer OpenOffice.org, il suffit de cliquer sur l'icône dockée
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Réglages complémentaires de X11

Pour compléter l'installation de X11, et le tester, il suffit d'aller dans le dossier Applications/Utilitaires 
et de cliquer sur X11.  Vous pouvez même docker l'icône si vous le souhaitez.

Mode d'affichage

Lors du premier lancement de X11 (ou l'un des suivants), il faut penser à faire les réglages suivants : 
Allez dans X11 -> Préférences et vérifiez que votre affichage est bien réglé en millions de couleurs.

Utiliser International 

Si vous souhaitez utiliser d'autres caractères (le grec, l'arabe, le russe ...etc) qui sont disponibles dans 
International, veillez à ce que la case Utiliser la disposition du clavier système soit cochée.
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B. Open Content Library (Open ClipArt & Open Font Libraries) 
Après le succès de la bibliothèque ouverte de ClipArt (Open ClipArt Library) et le lancement de la 
bibliothèque ouverte de Polices (Open Font Libraries), le projet Open Content Library 
http://opencontentlibrary.org/ a été créé afin de chapoter le développement des nouvelles et déjà 

existantes communautés pour la création, partage et distribution du contenu digital libre. 

OpenClipart

http://openclipart.org

Scalable Vector Graphics (SVG) est un format de données conçu pour décrire des ensembles de 

graphiques vectoriels et basé sur XML.

OpenOffice.org ne sait pas gèrer nativement les fichiers SVG, pourtant il existe 2 approches d'insertion 
d'images OpenClipart dans OpenOffice.org. La première utilise le format vectoriel qui offre par défaut 
une meilleure qualité et plus de souplesse. La seconde est d'utiliser le format bitmap/raster qui est 
nettement moins souple et de moindre qualite (voir fig. cihaut)

Utilisation du format vectoriel

Bien que OppenOffice.org ne possède pas de support natif pour les images SVG, il existe un tiers 
plugin sur http://haumacher.de/svg-import/
Ce plugin convertit les fichiers SVG en Graphiques OpenDocument en utilisant Batik. Il est encore en 
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developpement mais il donne des résultats raisonnables lors de la conversion des images SVG simples. 
Un tutoriel d'installation existe sur le site. En utilisant ce plugin, il faut selectionner Fichier > Ouvrir 
fichier SVG au lieu de Inserer > Image > A partir d'un fichier . 

Les mêmes personnes qui ont crées ce plugin ont également écrit un outilitaire qui s'appelle svg2office 
afin de convertir massivement des fichiers SVG vers des fichiers ODG. 

Inkscape est un autre programme qui peut convertir de SVG vers ODG.  

Utilisation du format Bitmap/Raster

Plusieurs images dans la bibliothèque Open Clip Art existent à présent en format PNG, qui peut être 
importer directement dans OpenOffice.org. Pour le faire il suffit d'aller  Inserer > Image > A partir d'un 
fichier. En plus, les images peuvent être converties vers de formats PNG, GIF, JPG, BMP en utilisant 
des programmes comme GIMP et Inkscape. 

Pour installer la bibliothèque OpenClipart : 

– Sous Ubuntu, installer le paquet openclipart soit via le gestionnaire des paquets Synaptic soit via la 
ligne de commande.

– Sous Windows, vous pouvez utiliser l'installateur qui se trouve sur 
http://openclipart.org/downloads/0.18/openclipart-0.18-win32.exe

OpenFonts Library  
http://www.openfontlibrary.org

Pour installer des fonts sur OpenOffice.org 

– sur Ubuntu, il faudra copier les fonts soit dans le répertoire /opt/openoffice.org/share/fonts/truetype/ 
s'il agit d'une installation commune à tous les utilisateurs ou dans le répertoire d' l'utilisateur 
spécifique ~/.openoffice.org/user/fonts/.

– sur Microsoft si vous les copiez-les sur c:\program files\OpenOffice.org 2.3\share\fonts(\truetype 
pour le .ttf) ils seront utilisés que par OpenOffice.org tandis que si installés dans c:\windows\fonts/ 
ils seront aussi utilisés par d'autres applications.
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C. Tutoriels ­ Liens Internet
http://www.openoffice.org Le site officiel d'OpenOffice.Org

http://fr.openoffice.org Le site officiel d'OpenOffice.Org en français

http://fr.openoffice.org/Documentation/Index.html Guides et tutoriels pour OpenOffice.Org

http://www.framabook.org/docs/OpenOffice/migration_ooo_framabook.pdf Le livre � Changer pour  OpenOffice.Org�

http://openclipart.org Open Clipart Gallery (site en anglais)

http://www.openfontlibrary.org Open Font Library (site en anglais)

http://why.openoffice.org Pourquoi migrer vers OpenOffice.org 
(site en anglais)

http://www.formation-openoffice.fr Site de tutoriels et vidéos pour 
OpenOffice.org (site en français)
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